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Introduction

Disclaimer

The information in this document is subject to change without notice and does not represent a
commitment on the part of Scaler Music. No part of this publication may be copied,

reproduced or otherwise transmitted or recorded, for any purpose, without prior written
permission by Scaler Music. Scaler Music and Scaler 3 associated logos are (registered) trademarks
of Scaler Music. Special thanks to the Scaler Music Forum and Beta Testers, who were invaluable

in making Scaler 3 a better tool.
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Scaler 3: Empowering Creativity

Scaler 3 is a powerful composition assistant that helps you identify scales, build
expressive chord progressions, and create melodic sequences with ease.

Designed to enhance creativity while keeping you in control, it streamlines the
composition process, making it faster and more intuitive.

With multi-track sequencing, real-time performance features, and intelligent harmonic
tools, Scaler 3 provides a dynamic environment for musical exploration.

It also includes an extensive library of curated chord progressions and performances
from world-renowned artists across a wide range of genres, offering endless inspiration

for producers, composers, and musicians alike.
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Learning Resources
In addition to this guide, the Scaler Music YouTube channel and the School of Synthesis
YouTube channel offer a wide range of tutorials, how-to and guided videos, and creative

walkthroughs.

Furthermore, the Scaler Music Forum hosts a vibrant and supportive community where
users can seek help and share insights.

Scaler Music YouTube Channel

School of Synthesis YouTube Channel

Scaler Music Forum

07 Onboarding Tutorial

When you launch Scaler 3 for the first time, an Onboarding Tutorial appears to help
you get started. Use the Next and Previous buttons to navigate through the slides.

You can exit the tutorial at any time by clicking Exit Tutorial in the top-right corner.
A prompt will ask whether to show the tutorial on startup — your choice will be
remembered.

To relaunch the tutorial later, click the Scaler 3 logo in the top-left corner, then
choose Help > Start Tutorial.

0% iPad Learning Resources

iPad users can find additional guidance on the Scaler Music YouTube channel, including a
dedicated playlist covering iPad gestures, using Scaler 3 for iPad within other iPad hosts,
and sharing presets with the desktop version.

You can also refer to the iPad-specific section of this manual for detailed explanations of
gestures and interface behaviour that differ from the desktop version.



https://www.youtube.com/@scalermusic
https://www.youtube.com/@SchoolofSynthesis
https://forum.scalermusic.com/
https://www.youtube.com/playlist?list=PLzUwuiQFNAPRGTOSp2DBeIaFtTRUgqtz4
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Installation & Registration

Downloading Scaler 3

Scaler 3 is available from either Scaler Music or Plugin Boutique. For details on redeeming
your license and accessing the installer, refer to the instructions in your Scaler Music or
Plugin Boutique account.

Once you’ve downloaded the installer for macOS or Windows, double-click the file and
follow the on-screen instructions.

Installing Scaler 3

During installation, you can choose which plugin formats and components to
install—such as VST2, VST3, AU (macOS only), AAX, and standalone—based on your
system and preferences.

Plugin Scanner
Scaler 3 can host third-party instrument and effect plugins directly on Chord Tracks and
MIDI Lanes.

As part of the installation process, Scaler 3’s Plugin Scanner will launch automatically.
This step ensures that your audio plugins are properly located and available in Scaler 3.

Scaler 3 would like to scan your system for plug-ins.

Plug-in formats to scan:
v | VST v | VST3

Add Custom VST Path

Plugin Formats

By default, all plugin formats are selected for scanning to ensure Scaler 3 can locate your
installed instruments. You can choose to include or exclude: VST, VST3, and AU (macOS
only).

Custom VST Paths
Scaler 3 allows you to specify up to three custom folders to be scanned for VST plugins,
which is useful if your plugins are installed outside the default directories.

« Add Paths — Click the Add Custom VST Path button to include additional folders.
« Remove Paths — Use the x next to a folder to remove it from the scan.
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Plugin Scan Controls
* Scan - Begins scanning using the selected formats and paths.
+ Skip — Bypasses the scan. You can scan plugins later by selecting
“Rescan Your Plugins” from the Settings Menu > Preferences.

Note: Scanning may take some time depending on how many plugins are installed on
your system.

Once the scan completes, the installer will finalise automatically.

Activating Scaler 3
On first launch, Scaler 3 runs in trial mode for 14 days with full functionality. After the
trial period expires, Scaler 3 must be activated to continue use.

Note: An internet connection is required during activation.

To activate your license:
1. Open Scaler 3 in your DAW or launch the standalone version.
2. Click the Scaler 3 logo in the top-left corner and choose Registration.
3. Enter your license code and click Activate Scaler 3.

Welcome to Scaler 3

Once activated, Scaler 3 is fully licensed and ready to use—no internet connection
or login required.

For troubleshooting tips or help with activation, visit scalermusic.com/support.



https://scalermusic.com/support/

Introduction > Quick Start 11

Quick Start

Browse Page §) Scaler 3 Noproset Header
Find a pre-made chord set
using the browser in

Section A= === === mmmenn

Use the tabs on the

top left to select one

of the three pages:
Browse | Create | Arrange

B £ =

Chord Set Coloured 1

Common Progressions Coloured 1

Find chords belonging to a
particular scale using

Section B. CurtentScale G ofrscole v Global Controls
For a variety of
C Major scale 7 MAJOR 1ST HAPPY - LIGHT - BRIGHT - POSITIVE real_time Chord VOiCing

Drag chords to Section C
to create your own custom
chord progression.

adjustments, activate a
Voice Grouping profile.

Main Track Felt Piano

Enable and browse Motions
to perform your chord
progression expressively.

To automatically tune
incoming MIDI notes to
your selected chord or
scale, activate Keys Lock.

Arrqnge que S Scaler3 B No Preset
Add tracks using the + icon Arrange

in the top left.

This will display the Motion
browser.

Ay

WallTTre= = = A

A track will be created
based on the Motion Select a clip and use
selected. This track will the sidebar controls
automatically follow your ® to change the Motion
Main Track chords. pattern, or make

) ) modifications to
: P the existing Motion.

© None

Aftablle

O Feitpiano

Main Track Arpeggio Master

Mixer
Use mixer channels to
adjust each track’s volume, 0)
pan, mute, or solo.

()

Felt Piano Felt Piano Felt Piano

N Use insert slots to

one None None

select an instrument
sound, or a 3rd party
instrument plugin with
multiple audio effect
slots.

None None None

None None




Create Page §) Scaler 3
Circle of Fifths

Use the Circle of Fifths
page to find new chords or
modify existing chords.

Current Scale

For chord suggestions,
select a key from the
Circle of Fifths, or select
notes on the keyboard.

Main Track

Create Page § Scaler3

Explore curtent sele
Browse expansive
chord constellations via
Genre and Mood.

Dynamic Scale
automatically adjusts the
color of all chords to show
how closely they relate to
the last played chord.

Main Track

Create Page 8 Scaler 3

Colors

Quickly browse and
audition voicing variations
and substitutions for
your selected scale’s
diatonic chords.

Click the voicing name on
the left to select an
alternate voicing for that
row of chords.

Main Track

Current Scale

No Preset

FoltPiano

No Preset

Felt Pano

Cmaj

Fmaj

Cmaja...

Gmaja..
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Search for any chord by
typing.

Select a chord from
Section C to edit notes
via the keyboard, or via
the controls at the top of
the Circle of Fifths page.

Chords around the
inner circle are safe and
those around the

outer circle are more
adventurous.

Chords on the left tend
to sound darker, whereas
chords on the right sound
brighter.

Then drag chords to
Section C to add to your
progression, or for further
editing via the Circle of
Fifths page.
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Quick Tips

Scaler 3 includes a variety of global presets designed to help you get started
and discover the features of Scaler 3. These can accessed via the preset menu
in Scaler 3’s Header.

= Scaler3

If you are coming from Scaler 2, it is possible to import your User Chord Sets
for use in Scaler 3. Either click use the ‘Import Chord Set’ button from the User
category in Section B, or drag your own folders or XML files into the Scaler 3
‘ChordSets’ folder using your computer’s file browser.

For more, see Browse Page > Section A > User Chord Set Management.

When dragging chords, make sure to align the left side of the chord with the
intended destination e.g. between chords to add to the existing progression,
or on top of chords to replace existing chords.

In the below image, a B dim chord is being dragged from Section B onto the Main Track in Section
C, between the F maj add 9 and G maj add 9 chords.

MAJOR 15T HAPPY - LIGHT - BRIG

When dragging chords to your Main Track in Section C, they default to a length
of one bar, relative to your selected time signature. You can manually adjust
chord lengths after adding them; however, you may need to adjust the division
setting on the Arrange Page to accommodate finer changes, as the default
division is set to one bar.
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-(): Horizontal Scroll & Zoom Bar

Visible in most sections of Scaler 3, the horizontal scroll and zoom bar
provides two functions:

* Scroll - Click and drag anywhere within the bar (except the edges) to move
left or right across your chord progressions or motion patterns.

e Zoom - Click and drag the left or right edges of the bar to zoom in or out.
Dragging inward (towards the center) zooms in, while dragging outward
(away from the center) zooms out.

Quick Scroll Shortcut — Hold the Shift key and scroll the mouse wheel up or
down to scroll left or right.

2(): Hold the shift key and left-click on a chord or motion clip to mute or unmute it.
Muted clips appear greyed out. This is especially useful in the Arrange Page
sequencer when you want to mute certain chords from your Main Track
progression while still allowing motion clips to follow their harmonic content.

= No Preset

A Harmonic Major scale

In the above image, the E major chord has been muted. The motion clip below
remains active and continues to react to the harmonic content of the muted chord.
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"

-()- Auto Voice Leading. With more than one of your Main Track chords
“ selected, enable Auto Voice Leading to let Scaler 3 apply efficient note
movement between chords — reducing leaps and following classic voice
leading principles for more cohesive progressions.

Arrange D#/Eb Major scale

1
1
1
1
1
1
:
v

Main Track

I Aul

MIDI Editor

2(): Easily extend or shorten adjacent chords with a single drag. When you resize
“ achord in the Main Track, Scaler 3 automatically adjusts the length of the
adjacent chord based on the current grid resolution set on the Arrange Page.

2(): Quickly duplicate chord clips with a modifier-drag. Hold Option (Mac) or
“ Alt (Windows) and click-drag a chord to copy it to a new location.

MAJOR 3RD EXOTIC - LATIN - LIVELY
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Operating Modes

You have the choice of running Scaler 3 as a standalone application, in which it will
behave like any other program on your computer. Alternatively, you can use it as a plugin
(instrument, audio, or MIDI effect) within your DAW (Digital Audio Workstation) or
compatible host.

Plugin Operation

The instrument, audio, and MIDI effect plugin versions of Scaler 3 listed below work with
most Digital Audio Workstations (DAWSs) and are available in VST, AU, and AAX formats. To
start using Scaler, load it onto a software instrument, audio, or MIDI track in your DAW. If
you’re unsure how to do this, refer to your DAW’s manual for specific

instructions.

If your DAW organizes your plugins by vendor, you will find the various Scaler 3 plugins
listed below under ‘Scaler Music’.

Scaler Plugin Versions
Scaler 3 is available in different versions to suit various workflows:

Scaler 3 (Virtual Instrument)
* Designed for use on MIDI/instrument tracks.
» Detects chords from both MIDI and audio input
« Can send MIDI output to external instruments via multichannel MIDI (if supported
by your DAW or compatible host)

Scaler Audio 3 (Audio FX)
* Designed for use on audio tracks
* Analyzes and detects chords and scales from audio input
» Ideal for working with pre-recorded audio, samples, or live instruments

Scaler 3 Control
» Designed for DAWs that support MIDI Controlled Effect plugins (MIDI FX*)
* Includes the same detection features and exclusive content as Scaler 3
» Ideal for controlling external instruments within DAWs that only support AU plugins,
such as Logic Pro
« Does not generate sound; requires a separate instrument plugin on the same track
for audio output

*Not compatible with all DAWs. Refer to the manual of your DAW for more information on how to route audio
and MIDI in your software.
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Standalone Operation

Scaler 3 can also be used as a standalone application, allowing you to work
independently of a DAW. Once launched, Scaler 3 will function like any other software on
your computer. You can configure audio and MIDI settings within the application to ensure
proper input and output routing. This mode enables you to explore Scaler 3’s features,
play and manipulate chords, and experiment with musical ideas without requiring a DAW.
Select Options at the top left of the Scaler 3 standalone application to access:

Audio/MIDI Settings

Feedback Loop — When on, audio input is muted to avoid a feedback loop.
Audio Device Type (Windows) — Select an audio driver type. Generally ASIO achieves
the best performance.

Output - Set to your preferred output device. Select “Test” for a tone to
confirm the output destination registers sound from Scaler 3.

Input — Set to your preferred input device.

Active Output Channels — Enable or disable channels.

Active Input Channels - Enable or disable channels.

Sample Rate — Adjust the audio sample rate.

Audio Buffer Size — Adjust the buffer size.

Active MIDI Inputs — Enable or disable MIDI inputs.

Bluetooth MIDI - Enable Bluetooth MIDI connections.
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Interface Overview

Scaler 3 features a structured interface designed for both exploration and composition.
The Header Section and Global Controls remain visible at all times, providing essential
navigation and playback functionality. The core workflow is divided across three main
pages: Browse, Create, and Arrange, each offering specialized tools for different stages of
the music-making process. The following is a high-level overview of these sections, with
more detailed explanations provided later in this guide.

Header Section. This section offers key navigation, playback, and customization controls
and remains visible at all times when using Scaler 3.

Browse Page. The main Scaler 3 page used to browse scales and chord sets, and create
your own custom chord progression.

Create Page. A variety of compositional tools to help you create and discover chords, and
to help you develop the rest of your song.

Arrange Page. Add additional instruments to your song with full multi-track mixing and
editing control.

Instrument Panel / Global Controls. Visualize and play Scaler’s sounds using a keyboard
or guitar interface, and control a variety of playback parameters related to the Main Track.
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Recurring Features

Binding Chords

As well as triggering chords by clicking on them with your mouse, you can also ‘bind’
sections of Scaler’s interface to trigger chords with individual MIDI notes. This is
accomplished by clicking the ‘bind’ button to the right of certain rows of chords.

The inactive bind button indicates that its corresponding row or group of chords can be
bound and triggered via MIDI notes.

When the icon is highlighted in yellow the selected row or group of chords is bound,
meaning incoming MIDI notes will trigger the corresponding chords.

Additionally, Scaler 3’s on-screen keyboard/piano will indicate the bind range by
displaying yellow highlights with the bind icon at the bottom of the keys.

By default, the bind range is mapped to the white keys from C2, but this can be adjusted
in Settings > Playback Menu.

Keyswitches

Keyswitches are MIDI notes which let you quickly choose which section is bound when
there are multiple BIND buttons. They provide flexibility for live performance, playback,
or arranging, enabling you to move between variations or progressions with a single
keystroke.

Location and Mapping
On Scaler’s on-screen keyboard, keyswitches are highlighted in green. By default, they are
mapped to the lower keys, starting from C1.

How They Work

Pressing a keyswitch triggers the corresponding bound area or lane, allowing you to
switch between multiple bound rows or lanes on pages that feature more than one BIND
button, for example, the Colors and Sketch pages.




Introduction > Recurring Features 20

Suggest Mode

Suggest Mode provides chord suggestions, generates entire patterns, or helps complete
your existing progression. While it is primarily associated with Section C — Main Track, it
is also accessible via Sketch on the Create Page, making it a recurring feature.

For a detailed explanation, see Section C - Main Track > Suggest Mode.

Colors

Colors in Scaler 3 allow you to easily enhance basic triads with harmonic variations,
helping you create richer, more expressive chords. This includes extensions, custom
voicings, and functional variations such as tonics, subdominants, substitutions, and
inversions, giving your progressions more depth and character.

While a dedicated Colors page exists within the Create Page, quick access is also
available via Section B — Current Scale on the Browse Page, making it a recurring feature.

Click the current voicing name (e.g. Triads) to open the Colors browser to choose a shape
or voicing variation for the diatonic chords of the selected scale. Use the arrow buttons to
quickly cycle through available variations.

Cb maj Db maj

Vi Vil

For a detailed explanation, see Create > Colors.
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Live Sync

Live Sync allows you to synchronize your Main Track chord progression across multiple
open instances of Scaler 3. Whether you’re working on multiple tracks in a single DAW
session, or running Scaler 3 in parallel across different sessions or systems, Live Sync
helps keep everything harmonically aligned.

This feature is especially useful when using multiple Scaler 3 instances to control
different instruments or apply different Motions, as it allows you to apply the same
chord progression across them without the need to copy and paste manually.

As the Main Track chord progression is relevant across both the Browse and Arrange
Pages, Live Sync is considered a recurring feature in Scaler 3. For more information
about the Main Track, refer to Browse Page > Section C and Arrange Page > Main Track.

Each instance of Scaler 3 can either act as a Leader or a Follower:
e Leader - Sends its Main Track chord progression to all Followers.
* Follower — Automatically updates its Main Track to match the currently
selected Leader.

Activating Live Sync

Set the Leader
On the Browse Page or Arrange Page, open the menu on the Main Track and
select Live Sync > Lead.

§ Scaler3 B New Session [Default]

Arrange F#/Gb Phrygian Domin.
-7

(|
Lo

Clear Track

Select All

Midi Channel

Live Sync

Follow (No Leader Active)

Auto Sync

You’ll see the message: Activate Leader Mode. All other instances with Auto Sync enabled
will follow this instance’s main track chords.

Followers
All other Scaler 3 instances with Auto Sync enabled will act as Followers, automatically
updating their Main Track to reflect changes made on the Leader.

To manually set an instance as a Follower — for example, if Auto Sync is disabled
or the sync connection was broken — open the three-dot menu on the Main Track and
select Live Sync > Follow.

If no Leader is active, the Follow option will appear grayed out in the menu with the
label: Follow (No Leader Active).
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Once Live Sync is enabled, a label appears on the Main Track, indicating each instance’s
current role.

Main Track Scaler 2
Follower

Main Track Staccato Strings
Leader

-()- For a workflow similar to Scaler 2, try using Main Track Sync and
“ Global Parameters (like Quantise and Motions) instead of the Arrange Page.
By turning DAW Sync OFF, you can record trigger notes directly in your
DAW, allowing for more manual control and flexibility in performance.

Breaking Sync
* Making any manual change to the Main Track on a Follower will disable its sync
status.
* You will see: Disconnect from Live Sync. This action will remove this instance from
Live Sync — it will no longer follow the leader.
* Turning off Live Sync on a Leader will stop sync across all connected instances.

Auto Sync

The Auto Sync feature determines whether a Scaler 3 instance will automatically join a
Live Sync group when a Leader is active.

When Auto Sync is ON
* The Scaler 3 instance will automatically follow the instance designated
as the Leader
* Its Main Track will be overwritten to match the Leader’s Main Track.
* This ensures seamless synchronization across all instances in your session.

When Auto Sync is OFF
* The Scaler 3 instance will not follow the Leader and will retain its own content.
* This prevents accidental overwriting of your Main Track chord progressions.
* Once disabled, the instance will remain disconnected from Live Sync unless
manually reconnected.
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Header Section
About Menu

To access the About Menu, click the Scaler 3 logo at the top left of the header section.

The version of Scaler 3 you are currently using can be found at the top left of the window.

Registration

This is where you can activate Scaler 3, purchase a license, continue in trial mode, or
view the successfully registered status of Scaler 3. For more information, please visit the
Installation and Registration section of this user guide.

Help

This section includes links to the Onboarding Tutorial, Video Tutorials, User Guide, the
Scaler Music website and FAQ section, as well as the Scaler Music Community Forum.

Registration

Credits
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Navigation Tabs

Access Scaler 3’s core pages: Browse | Create | Arrange

Each of these pages will be described in detail over the following chapters of this
user guide.
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Presets

The Preset Section allows you to load and save presets containing chords, multi-track
arrangements, internal and external instruments, and effects.

® Super Techno Track

When Scaler 3 is in its default state, the Preset Indicator displays the text New Session.
If a preset is loaded, its name will appear in this area.

Clicking on the Preset Indicator opens the Preset Browser, where you can explore
Scaler 3’s factory presets, categorized by genre, or filter by Favourites and your own User
Presets. You can also search for presets using the search field in the top left.

Main Presets

Template - Chill Arrangement

Favourites Template - DNB 172 BPM

User Template - Dramatic Score

Template Template - Dreamy Synthwave 90 BPM
Template - EDM Starter 130 BPM
Template - Ethereal Pop 100 BPM
Template - House and Garage
Template - Mellow Tines
Template - Nice Strings

Template - Orchestral Rock

To the left of the Preset Indicator is the Favourite button, which adds the current preset
to your Favourites for quick access

When hovering over the Preset Indicator, additional controls appear:

Previous & Next Navigation — quickly scroll through presets

Beautiful Strings

Save button
Save the current session state as a User Preset. Clicking this icon opens a dialog box to
select a save location.
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Detection

Scaler 3’s Detection feature allows you to identify the chords and scales in MIDI or
audio material. It analyzes the incoming content and displays detected chords in
Section A, with suggested scales shown in Section B. This makes it easy to understand
the harmonic structure of a file or performance and explore new musical directions.
Detection can be carried out in several ways, which are explained in the sections below.

To access the Detection popup, click the Detect button.

. o . Capture MIDI

Scaler 3 offers three detection methods:

* Capture MIDI
e Detect MIDI
* Detect Audio

To select a detection method, click the three horizontal bars next to the currently
selected detection method. Note: the default detection method is Capture MIDI.

Capture MIDI

Detection Controls Overview

Detect Button
Starts or stops Capture MIDI, Detect MIDI, or Detect Audio.

Drag Button
Click and drag to export captured MIDI to your DAW or a folder on your computer
(Capture MIDI only).

Save Button
Save the captured MIDI data as a MIDI file via a file dialog (Capture MIDI only).

Folder Button
Opens a file browser to import MIDI or audio files for detection
(Detect MIDI / Detect Audio only).

Trash Bin Button
Clears detected chords from Section A (Detect MIDI / Detect Audio only).

Close Button
Closes the Detection popup.
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Capture MIDI

When Scaler 3’s Capture MIDI function is active, it continuously detects and records
incoming MIDI data from multiple sources, including notes performed live on a
connected MIDI controller, notes triggered via DAW playback, and notes activated directly
within the Scaler 3 interface (such as by clicking on chords or notes). This data is
temporarily stored until Capture MIDI is stopped, at which point the recorded material
can be dragged and dropped into a DAW, exported to a computer location, or saved
directly as a MIDI file.

To use Capture MIDI

1. With the Detection popup open, and the Capture MIDI method selected, click
the Record button. The Record button will flash, indicating that Scaler 3 is
actively monitoring for incoming MIDI data.

2. Trigger MIDI input by performing live on a connected MIDI controller, playing
back MIDI from your DAW, or clicking on notes and chords directly within the
Scaler 3 interface.

3. When you are finished triggering MIDI, click the Record button again.

The Drag icon will begin flashing, indicating that captured MIDI data is available.

4. Export the captured MIDI data by either:

a. Clicking and dragging the Drag icon into your DAW or a desired computer location.
b. Clicking the Save button to open a dialog box and save the captured MIDI data
directly as a MIDI file.

Detect MIDI

Scaler 3’s Detect MIDI function analyses incoming MIDI data in real time, via file import,
or through drag-and-drop directly onto Scaler 3’s interface. As MIDI is received, Scaler 3
extracts chord and scale information, displaying detected chords in Section A and sug-
gested scales in Section B.

To use Detect MIDI (real-time detection)

1. With the Detection popup open and Detect MIDI selected, click the Record
button. The button will flash, indicating that Scaler 3 is actively monitoring
incoming MIDI data.

2. Begin MIDI playback from the desired point in your DAW’s timeline, or perform
MIDI input live using a connected MIDI controller.

3. Scaler 3 will analyze any MIDI routed directly into the track it is loaded on,
including MIDI clips on that track or live input from a connected controller.

4. In real time, Scaler 3 displays detected chords in Section A, with corresponding
scale suggestions in Section B.

5. When playback or performance is complete, click the Record button again to
stop detection. The detected results will remain visible for further interaction,
such as binding or editing.

Note: This method can be used with either the Scaler 3 Instrument plugin on a MIDI or
software instrument track, or the Scaler 3 Control plugin in DAWs that support AU MIDI
effect plugins.
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To use Detect MIDI (file import)
1. With the Detection popup open and Detect MIDI selected, click the Folder button.
2. A file dialog will appear. Navigate to and select a MIDI file from your computer.
3. Double-click the file or click Open to import it into Scaler 3.
4. Scaler 3 will automatically analyse the file and display the detected chords in
Section A, with corresponding scale suggestions shown in Section B.

To use Detect MIDI (drag-and-drop)
1. Drag a MIDI file from your computer onto the Scaler 3 interface.
2. A prompt will appear asking you to confirm whether you’d like to overwrite
the current progression with the detected MIDI content. Click Yes to proceed.
3. Scaler 3 will automatically analyse the file and display the detected chords in
Section A, with corresponding scale suggestions shown in Section B.

Detect Audio

Scaler 3’s Detect Audio function enables you to analyse and extract chord and scale
information from audio tracks in real time. As audio content is processed, Scaler 3
extracts chord and scale information, displaying detected chords in Section A and
suggested scales in Section B.

To use Detect Audio (real-time detection)

Note: In most cases, the simplest way to detect audio is by inserting the Scaler Audio 3 (Audio FX) plugin di-
rectly onto an audio track. However, you can also use the Scaler 3 (Virtual Instrument) plugin by routing audio
into it via side chain. Since the side chain setup process varies between DAWSs, please refer to your DAW’s doc-
umentation for specific instructions on how to configure side chain input.

1. With the Detection popup open and Detect Audio selected, click the Record button.
The button will flash, indicating that Scaler 3 is actively monitoring incoming
audio data.
2. Start playback from the desired point in your DAW'’s timeline, or perform live
audio through an instrument such as a guitar routed into the track.
3. As the audio plays, Scaler 3 will analyse the content and display the
detected chords in Section A, with corresponding scale suggestions in Section B.
4. When you’re finished, click the Record button again to stop detection.
The results will remain visible for further interaction, such as binding or editing.

To use Detect Audio (file import)
1. With the Detection popup open and Detect Audio selected, click the Folder button.
2. A file dialog will appear. Navigate to and select an audio file from your computer.
3. Double-click the file or click Open to import it into Scaler 3.
4. Scaler 3 will automatically analyse the file and display the detected chords in
Section A, with corresponding scale suggestions shown in Section B.

To use Detect Audio (drag-and-drop)
1. Drag an audio file from your computer directly onto the Scaler 3 interface.
2. A prompt will appear asking if you want to overwrite the current progression
with the detected audio content. Click Yes to proceed.
3. Scaler 3 will automatically analyse the file and display the detected chords in
Section A, with corresponding scale suggestions shown in Section B.
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Transport Controls

The Transport Controls allow you to manage playback and looping within Scaler 3.

Play Button
Starts playback of the Main Track sequencer. Right-click to toggle DAW Sync on or off.
The Play button is replaced by the Stop button during playback.

Stop Button
Stops playback of the Main Track sequencer. The Stop button is replaced by the Play
button when playback is stopped.

Rewind Button
Resets the Arrange Page sequencer to the start position.

Loop Button
Activates the loop region in the Arrange Page sequencer for continuous playback.

DAW Sync

The plugin version of Scaler 3 seamlessly integrates with your DAW, keeping everything in
sync — including transport, tempo, time signature, and playback position. When DAW Sync
is enabled, Scaler 3 follows your DAW’s transport controls, automatically updating its
position to match your project timeline, including tempo, time signature, and bar position.

¢ Playback Sync — Press play in your DAW, and Scaler 3 will follow along, staying
locked to your arrangement.

¢ Dynamic Position Tracking — Scaler 3 instantly jumps to the correct bar when
you start playback and updates its position in real time based on your
DAW'’s transport, ensuring precise synchronization throughout your workflow.

¢ Loop Region — When DAW Sync is enabled, Scaler 3’s loop region remains active
and aligned with your DAW'’s playhead. You can define this playback range using
the Loop Markers, and it will stay fixed within Scaler — even if playback starts
from different points in your DAW. Scaler will always begin from the corresponding
position within the loop, making it easy to focus on specific sections of your
timeline.

¢ Tempo & Time Signature Sync — Scaler 3 automatically follows your DAW’s
tempo and time signature, keeping all rhythmic elements aligned.

-()= With a loop region active on Scaler 3’s Arrange page, and DAW sync mode
enabled, the bar at which Scaler will begin playback from is relative to your
DAW'’s playback position. For example, with a four bar loop active in Scaler 3,
Scaler will treat every four bars of your DAW’s timeline as duplicates of its own
four bar loop. So playing your DAW from bar 2 will start Scaler’s four bar loop
from bar 2. Starting your DAW’s playback from bar 6 will also start Scaler at
bar 2, as if Scaler’s loop region stretched from bars 5 - 8 in your DAW, instead
of bars 1-4.
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Timing Indicators

These indicators and controls display key timing information for Scaler 3’s internal
sequencer, or when DAW Sync is enabled, align with your DAW’s parameters.

1. Sequencer Position — Displays the current playback position in bars and beats.

2. Time Signature — Shows the time signature of the Arrange Page sequencer.

3. Metronome - Toggles an audible click to help keep time while playing or recording.
4. Tempo - Displays and controls Scaler’s global tempo.

Standalone
When using Scaler 3 standalone, the time signature and tempo can be adjusted using the
timing indicators, which serve as interactive controls.

» To change the time signature, click and drag up/down on the numerator
(first number) or denominator (second number).

» For tempo, click and drag up/down on the left side of the control to adjust in
single BPM increments. Drag up/down on the right side to adjust in 01 BPM
increments.

» Double-click the tempo control to reset it to 120 BPM.
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Exporting

Scaler 3 allows you to export either audio or MIDI, with flexible options for bit depth,
sample rate, and file structure. You can export either a loop region or the entire
arrangement from the Arrange Page sequencer.

You can also export chord sets.

Select the Export button to open the Export window.

Export Type Options Description

Audio Export Bit Depth 16-bit, 24-bit, or 32-bit float
Sample Rate 441 kHz, 48 kHz, 88.2 kHz, or 96 kHz

Anti-Cli On prevents clipping. Off allows full
P volume output, which may cause clipping
Loop exports the loop region, or

E R
Xport Range Arrangement exports the full sequence.

Loop exports the loop region, or
MIDI Export Export Range Arrangement exports the full sequence.
Single Track — Merges all tracks into one

MIDI File Format MID! file

Multi Track — Exports each track as a
separate MIDI file

Exports the Main Track chord set in .xml

Chord Set Export Main Track Chord Set
format.
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Misc. Header Features

Midi Panic
Send “All Notes OFF” message to stop any stuck/hung MIDI notes

Undo & Redo

Scaler 3 includes Undo and Redo functions to help you easily revert or reapply changes:

Undo - Reverts the last action performed, allowing you to step back through your
changes.

Redo - Reapplies the most recent undone action, letting you move forward again.

Output Level

Scaler 3 provides a visual indicator of its audio output level, allowing you to monitor the

volume of the sound being generated.
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Settings Menu
The Settings Menu in Scaler 3 allows you to customize playback behavior and user
preferences to suit your workflow. It’s divided into two sections: Playback & Preferences.

Additional Quick Actions are accessible from the same menu icon.

Playback - Controls timing, MIDI binding, performance settings, and synchronization
options.

Preferences — Adjusts interface behavior, MIDI input/output settings, and additional
customization options.

Quick Actions — The menu icon in the top-right corner also provides fast access to
commonly used actions.

To access the menu, click the menu icon in the top-right corner of the header. This opens
a drop-down menu containing Quick Actions and a link to the Settings Menu.

New Session

Reset to Default Size

Settings Menu

Quick Actions

* New Session — Reset the current Scaler 3 session as if you’ve just opened it.
A confirmation prompt appears before your current session is cleared.
* Reset to Default Size — Reset to the window size as if you first opened it.
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Playback Menu

Chord Preview Duration

Sets the standard duration of a chord, which determines how long each chord will play
for when previewing progressions other than the Main Track, such as Section B, Sketch
Page, and Colors Page progressions.

Default Velocity

The Default Velocity value determines the velocity at which all chords except those on
the Main Track will be previewed when clicked on, or when played using their respective
play buttons. This also determines the initial velocity of chords dragged to the Main Track.

Once added to the Main Track, each chord’s velocity can be edited per note via the Circle
of Fifths page, or the Arrange page MIDI editor. Main Track chords with edited velocities
will be previewed in accordance with their own velocity when clicked, ignoring the Default
Velocity value.

When triggering bound chords using a velocity sensitive MIDI controller, the Default
Velocity, or the edited velocity value determines the chord’s maximum triggered
velocity.

Sync To DAW
Toggles synchronization with your DAW’s tempo and transport controls
(plugin operation only).

Play Quantize
Delays the start of the pattern to the next beat. Allows you to play in time and to tempo.

Play Quantize To
Delays the start of playback to align with the next beat, ensuring tighter timing.

Perform Mode
Determines how melodic and phrase content behaves when switching chords:

* Follow — Melodic and phrase content continues from its current position
but adapting to the new chord.

* Retrigger — Melodic and phrase content restarts from the beginning when
switching chords.

Latch
Toggles whether expressions continue looping after you release the chord trigger. When
enabled, performances will keep playing, allowing for continuous one-shot playback.

Motion on Bound Chords Only
Toggles whether motion patterns are applied exclusively to bound chords in your Main
Track progression.
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Playback Menu (continued)

Active Bind Keys
Determines which keys on your MIDI controller are used for chord triggering:

* White - Binds only to white keys.

+ Black - Binds only to black keys.

« All - Binds to both white and black keys.

* True Scale - Binds chords only to the notes of the currently selected scale.

Note: When using chord-based Keys Lock modes (e.g. Chord Notes, Chord Extensions, Chord Scales),
this is always set to ‘Black Keys’

Bind Octave
Shift the entire bind range by octaves.

Bind Semi Transpose
Shift the entire bind range by semitones.

Keys Lock Chord Mute

When enabled (with Keys Lock active), Main Track chords are muted so that only motions
or Keys Lock melody notes are played. Note: this only works for chord based Keys Lock
profiles.

Keyswitches
Toggles whether keyswitches are active. When enabled, you can switch between bound
areas by clicking a keyswitch or triggering it via MIDI.

Preferences Menu

Show Tooltips
When enabled, tooltips will appear when hovering over interface elements. Disabling this
option hides tooltips.

Show Bass Inversion
When enabled, the bass note is displayed in the chord name when chords are inverted.
When disabled, the bass note is hidden from inverted chord names.

Set Default Instrument to No Sound
Starts new sessions with no default instrument loaded. Set to ‘On’ then select
Save As Defaults to make this the default for future sessions.

Set Current Size As Default
Saves the current window size as the default for future sessions.

Rescan Your Plugins
Scaler 3 will rescan your plugin library to detect any newly installed or updated plugins,
or if the plugin scan was skipped during installation.
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Browse Page

S Scaler3 B No Preset A
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All Scales
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Current Scale G#/Ab Dorian b5 scale
1% V. il

Main Track

Overview

The Browse Page is primarily used for exploring scales and chord sets, helping you build
custom chord progressions. It also includes several additional functions which will be
covered in the following sections.

The Browse Page is divided into three sections: Section A | Section B | Section C

S Scaler3 B No Preset ) s

Fi#t min9 D# min7. F#fmaj.. GHmin..  A#7(#5)

Chord Set Contemporary Funk? -
vii s

Al Scales

Current Scale G#/Ab Dorian b5 scale . - :I‘m] :.aug :itulm riads [¢ :O:
You can adjust the layout by
resizing Section B.

Drag its upper border up or
down to allocate more space
to either Section A or Section C
based on your workflow needs.
To quickly reset Section B to its
default position, double-click
its upper border.

Main Track ¢ Felt Piano
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Section A
Browse Scales & Chord Sets

Section A is used for browsing Scaler 3’s library of scales and chord sets, including your
own saved or imported user chord sets.

Use the menu on the left to choose which content is displayed to the right, as well as
what can be selected using Section B beneath.

S Scaler3 n No Preset [

GH#7(su.. D#min7 | F#maj.. GH#min. A#7(#5)  Fi#maj7
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Common Progressions 1-IV-I-V (Resolving)

A# min B min C# maj D aug E# dim
Current Scale G#/Ab Dorian b5 scale
(] i v V. vio

G#/Ab Dorian bS5 scale HARMONIC MAJOR 2ND MYSTERIOUS - DARK - UNSTABLE

Main Track Felt Piano

Note that in the above image, Section B has been resized, allowing more space for Section A.

Browsing Scales

Selecting ‘All Scales’ at the top of the list allows you to explore Scaler 3’s full database
of scales. Scales can be chosen in Section B below, and will appear in Section B’s header
once selected.

)
1

All Scales

For details on working with selected scales, refer to Browse > Section B.
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You can search for and filter scales in multiple ways: by selecting notes on the Section A
keyboard, filtering by modes or moods, entering a scale name into into the Scale Selector
in Section B, or using a combination of these methods.

S Scaler3 0 Preset o
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Chord Set

HEROIC - MAJESTIC

Filtering Options

Section A Keyboard
« Clicking a note sets it as the root note (e.g., selecting ‘C’ will display all ‘C’ scales:
C Major, C Minor, etc.).
+ Selecting additional notes refines the list to scales that contain those notes whilst
still acknowledging the selected root note
» Clicking on the selected root note again deselects it to display all matching scales
regardless of root note.

Modes (scale types) — Filter scales by major, minor, harmonic minor, melodic minor,
double harmonic major, and various modal variations.

Moods — Browse scales based on their emotion or feel.

To reset all filters, click ‘Clear All Filters.

Scale Search via the Scale Selector in Section B
You can also search for scales directly from the Scale Selector in Section B. Click the
Current Scale field to search and browse available scales.
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Browsing Chord Sets

A chord set is a collection of chords representing a progression or song saved in Scaler.
Chord sets help you find inspiration, listen to chord voicings in context, and discover how
different progressions and songs are structured.

S Scaler3 B No Preset o
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Chord Set Vasan &

Common Progressions
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1-IV-V-IV (Journey)

C Major scale MAJOR 1ST HAPPY - LIGHT - BRIGHT - POSITIVE

Main Track Felt Piano

In Section A, you can browse various chord sets included with Scaler 3, as well as your
own saved or imported sets. You can choose a chord set from one of five categories or
filter by mood or favourites:

+ Common Progressions — A list of widely used chord progressions, available with
various voicings.

* Uncommon Progressions — A collection of uncommon progressions, available with
various voicings.

* Genre Sets — Chord sets organized by musical genre.

* Artist Sets — Chord sets crafted by artists.

+ User Sets — Chord sets you have saved.

Additional filters:
Moods - Filter chord sets based on emotion or feel.
Favourites — Access chord sets you have marked as favourites.

Tip: Select the heart button next to a chord set to add it to your favourites list.

Tip: With multiple chords selected in Section C, right-click and choose
‘Save As User Chord Set’. These chords will appear in the User Sets category.
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User Chord Set Management

Scaler 3 includes options for managing custom chord sets, making it easier to organize
and maintain them. This is particularly useful for users migrating from Scaler 2.

Users can import a single chord set as a .xml file or import entire folders for bulk
access. Additionally, it is possible to create, rename, and delete user folders directly
within Scaler 3’s interface.

S Scaler3 No Preset

Db maj Cmaj
Chord Set G Maj Chord Set
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Current Scale C Phrygian Dominant .
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C Phrygian Dominant scale HARMONIC MINOR 5TH WORLD MUSIC - GYPSY - FLAMENCO - JEWISH

Main Track Felt Piano

Importing Chord Sets

To import a single chord set or an entire folder of sets:

1. Navigate to the User category in the left panel of Section A.
(Tip: Drag Section B’s upper border to resize and allocate more space to
Section A if needed.)

2. With the User category selected, click the ‘Import Chord Sets’ button.

3. A file dialog will appear. Navigate to a .xml file to import a single chord set, or
select a folder containing multiple chord sets.

4. Click Open (or double-click the file or folder) to complete the import.

Chord Set

% My Chord Sets

Current Scale
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Note: The folder structure must exist on your computer before it can be displayed in Scaler
3. When chord sets are imported, Scaler 3 automatically creates the necessary files and
folders in the following locations:

macOS

/Users/[USERNAME]/Library/Scaler Music/Scaler 3/ChordSets

Tip: The Library folder is hidden by default. In Finder, click Go in the menu bar and hold
the Option key to reveal it.

Windows
C:\ProgramData\Scaler Music\Scaler 3\ChordSets

Folder Management
To manage user folders:
1. In the User category, select an existing folder.
2. Click the three-dot icon beside the folder name to reveal management options.
3. From this menu, choose to either Create, Rename, Delete, or select Reveal Location

to see the folder on your system.

Note: Newly created folders will appear nested under the currently selected folder.
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Section A Header

Once selected, chord sets appear in Section A's header, where you can preview them as a
full sequence, listen to individual chords, or drag them onto the Main Track (Section C) to
create your own custom progression.

& Scaler3 No Preset

E tritone F#6(su...
Chord Set Experimental 2

) Experimental 2
Experimental

Genres

Tip: Left-click individual chords to preview them, or right-click for more options.
Tip: Right-click chords to add them to the Main Track as an alternative to drag and drop.

In Section A’s header, you can:

Cmaja.. Eb sus2 Bb sus2 Ab maj7

Chord Set Coloured

1.
2.
3.
4.
5.
6

Wl agas | sus2 V sus2 V7

View the name of the selected chord set

Load the previous or next chord set from the selected category.

Play the currently selected chord set.

Lock the chord set to the current scale.

Drag up/down to transpose the chord set by semitones.

. Bind chords from the selected chord set to MIDI trigger notes (highlighted in yellow
on the keyboard).

Lock to Scale @

When Lock to Scale is disabled, chord sets appear in Section A in their original key
(e.g. C major, D minor), as defined by the set’s creator. The Lock to Scale button
appears as an open lock icon when disabled.

With Lock to Scale enabled, selected chord sets are automatically transposed to best
match the currently selected scale in Section B. For example, if the A major scale is
selected, incoming chord sets will be transposed to A major—or as close as possible.
The Lock to Scale button appears as closed lock icon when enabled.
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Section B

Current Scale

Section B consists of a header and Scaler 3’s full database of scales.

S| Scaler3 No Preset

Chord Set None.

Current Scale C Major scale

HAPPY - LIGHT - BRIGHT - POSITIVE

Main Track

Note that in the above image, Section B has been resized to its maximum height, allowing more space for
the Section B Scale List.

Section B Header
In Section B’s header, you can:

Current Scale C Major scale

1. View the currently selected scale, or click the field to search for other scales.

Play or preview the diatonic chords of the selected scale in a sequence.

3. View the chords belonging to the selected scale. Tip: Left-click individual chords
to preview them, or right-click for more options.

4. Quickly access the Colors menu to apply voicings or variations to the current
scale’s chords. For more details, please see Cross-Section Features > Colors.

5. Change the octave of the current scale’s chords by dragging up or down.

6. Bind chords from the selected scale to MIDI trigger notes (highlighted in yellow
on the keyboard).

N
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Scale List

Below the Section B header, Scaler 3 displays its full database of selectable scales. By
default, the complete list is shown and can be browsed by scrolling. The list updates
dynamically based on searches and filters applied via All Scales or selected chord sets.
Scales can be played or previewed using the Play button. To select a scale, click anywhere
on its row—you will see the Section B header update to reflect your choice.

S| Scaler3

Chord Set

Current Scale

HAPPY - LIGHT - BRIGHT - POSITIVE

Each scale is displayed under the following column headers:

* Note Match — The number of notes in the selected scale that match the user’s
chosen notes (e.g., if you select C, E, and G, this shows how many notes in the
scale contain those).

* Chord Match - How many of the chords in the scale match the currently
selected chord set or progression.

* Mode - The classification of the scale, such as Major, Minor, Harmonic Minor, etc.

* Mood - A descriptive label that categorizes the scale based on its
tonal quality, emotion, or feel.




Browse Page > Section C 45

Section C
Main Track

Section C is where you can build custom chord progressions, explore chord suggestions
that complement your chords, preview your chord set with an instrument of your
choosing, and save or export your chord set for future use.
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Working with Chords

Add Chords to the Main Track — Drag and drop chords from Section A or Section B into
Section C to start building your progression. To select multiple chords at once, left-click
near a chord on the header bar, hold the mouse button, and ‘lasso’ multiple chords
before dragging them into Section C.

S Scaler3 B No Preset
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Chord Set

Al Scales
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C Major scale HAPPY - LIGHT - BRIGHT - POSITIVE

Main Track Celestial Existence

In the above image, the D min chord is being dragged from Section B to Section C.
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Edit Chords — Modify any chord in your progression by right clicking and selecting Edit
Chord which takes you to the Circle of Fifths page for a variety of editing options. For
more details on editing via the Circle of Fifths page, refer to Create > Circle of Fifths.

Adjust Chord Length - You can change the length of a chord by clicking and dragging the
edge of its box. The length will snap to beats based on your chord duration settings.
By default, chord duration is set to 4 beats

To adjust these settings:
* Change default chord duration in Settings > Playback.
+ Update the time signature in your DAW with DAW Sync enabled or, in standalone
mode, by dragging the time signature values up or down.

Copy Chords — Copy any chord by holding Option (Mac) or Alt (Windows) while dragging it
to a new position.

Rearrange Your Progression — Reorder chords in your progression by dragging and
dropping them into different positions.

Add Rests — Create rests by leaving blank spaces in your progression. You can also add
rests from the Suggest window (explained in the following section). To remove empty
spaces, lasso multiple chords, right-click one of them, and select Remove Empty Spaces.

Add to Sketch — Quickly add chords to one of the seven Sketch progressions by
right-clicking a chord and selecting Add to Sketch: Progression 1-7. See Create > Sketch
for details.

Delete Chords — Hover over a chord and click the ‘X’ at the top right, or right-click and
select Delete Chord. To delete multiple chords at once, lasso them first and apply either
method to one of the selected chords

Play Your Progression — Press Play to preview your chord sequence.

Re-detect Your Progression’s Scale
You can re-detect the scale of your progression at any time. After adding or editing
chords, lasso your progression, right-click, and select Detect to identify the scale.

Main Track Felt Piano

In the image above, the D dim chord has been lengthened, blank space has been used to
create a rest, and Bb maj and Ab maj have been lassoed together, revealing the delete
button (X).
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Suggest Mode

Suggest Mode helps you discover new chords, complete your current pattern, or generate
an entirely new progression. It offers an intuitive way to find chords beyond the standard
diatonic chords of a scale. There are multiple suggestion methods, with the two primary

modes being Tonal and Per Scale.

Clicking the Suggest Mode button in Section C will open the Suggest Mode window.

Main Track Felt Piano

Suggest
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Per Scale

Per Scale mode suggests chords that belong to your current scale. This mode is useful for
expanding progressions with suspended and extended chords while maintaining

harmonic consistency. It analyzes movement between chords based on their degrees
within the selected scale.

For example, in the C Major scale, the relationship between G Major and C Major can be
defined as V = I. Since both degrees exist in the selected scale, Scaler considers them
harmonically linked.
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Tonal

Tonal mode suggests chords that complement your progression but may lie outside your
current scale. It analyzes chord sets curated by musicians and artists exclusively for
Scaler, allowing you to find harmonies that may not fit conventional scale-based music
theory. This mode helps you explore unique voicings and add richness to your chord
sequences.

For example, the relationship between F Minor and C Major cannot be defined using the
degrees of the C Major scale. However, F Minor is commonly played after C Major because
of various harmonic connections:
* Modal Interchange: F Minor exists in the C Phrygian, C Minor, and C Locrian modes.
* Minor Subdominant: In harmonic analysis, F Minor functions as a minor
subdominant (iv) of C Major.
* Shared Scales: Both chords co-exist in C Harmonic Major, C Phrygian Dominant, and
F Harmonic Minor.

Auto-Detect

With Auto-Detect enabled, Scaler continuously analyzes your progression and updates
the detected scale when you make changes. This ensures that chord suggestions remain
relevant, especially when switching between Per Scale and Tonal modes.

Minimize Movement

The Minimize Movement option helps keep suggested chords closer together in terms
of voice leading. Enabling this option ensures smoother progressions by reducing large
jumps between chords, making transitions feel more natural and connected.

This is especially useful when aiming for cohesive voicings that maintain a consistent

harmonic flow.

Live Suggest Mode

Live Suggest Mode allows you to trigger suggested chords in real time when chord binding
is enabled. Scaler 3 maps 8 suggested chords to MIDI keys starting from C4, letting you
experiment with different harmonic options live as you play.

This feature is useful for improvisation, real-time composition, or quickly testing
harmonic possibilities with your MIDI controller.

Pattern Fill

Clicking the Pattern Fill button generates a unique chord progression based on the
selected suggestion mode (Tonal or Per Scale). This feature allows you to either extend
your current pattern or create a fresh progression from scratch.
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Additional Section C Features

In Section C, you can also:

Bb miné F min

Main Track Brass Ensemble

1. Choose a sound for your Main Track chord progression. Click the Main Track Sounds

Panel to open the Sounds Browser, and fine-tune your sound or instrument using

the Sounds Editor. For more details, see Create Page > Mixer > Loading & Adjusting

Sounds.

Preview & play the currently selected Chord Set.

3. Drag your Main Track chords as MIDI into your DAW or onto a location on your
computer.

4. Bind your chord progression to MIDI trigger notes (highlighted in yellow on the
keyboard). For more details, see Recurring Features > Binding Chords.

N
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Create Page
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Overview

The Create Page offers a variety of compositional tools designed to help you explore,
develop, and refine your chord progressions. Whether you’re looking to expand a simple
idea, introduce harmonic complexity, or experiment with advanced music theory con-
cepts, this page provides powerful tools to shape your music.

The Create Page is divided into the following sub-pages, each offering unique ways to
modify, and enhance your chord progressions:

Circle of Fifths — Find new chords or modify existing chords.

Modulation — Explore harmonic relationships within your selected scale, borrow chords
from relative modes, find secondary scales for modulation, and discover suggested
progressions.

Explore — Browse expansive chord constellations in a non-linear layout, helping you
create unique chord progressions guided by Genre, Mood, and harmonic relationships.
Colors — Add expressive harmonic colors to your progression.

Sketch — Quickly build, organize, and refine your chord progressions.
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Interactivity with Sections B & C

While using the Create Page, Section B’s Header and Section C — Main Track remain
visible at all times, ensuring a fluid and interactive workflow.

Bb min C min Db maj Eb maj

Main Track

Section B displays the currently selected scale, which informs most Create Page tools by
guiding suggestions and transformations, though some tools extend beyond the scale for
broader harmonic exploration.

The ever-present Section C allows you to drag and drop chords to refine, rearrange, and
build upon your chord progression in real time as you explore different compositional
tools.
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Circle of Fifths

The Circle of Fifths page allows you to modify existing chords or find new ones.
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With a single chord selected, you can modify it:

Inversion — Choose different inversions to modify the chord’s voicing.
Semitones - Transpose the chord’s root up or down by a semitone.
Octaves — Raise or lower all notes of the selected chord by an octave.

Chord Suggestions
Select chords from your progression in Section C, or select notes on the
keyboard visualization for dynamic suggestions based on your selections.

Circle of Fifths Chord Suggestions
Select a key from the Circle of Fifths for key-specific chord suggestions.

Chord Search
Search for any chord by typing its name.

Additional Controls
* Enable/Disable Chord Preview when selecting chords from the Circle of Fifths.
» Display Notes or Velocity Values on your keyboard.
* Quick Reset — Use ‘Clear Notes’ to remove all selected notes instantly.

52
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Modulation

Explore harmonic relationships within your selected scale, borrow chords from relative
modes, find secondary scales for modulation, and discover suggested progressions.
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Choose from five modulation presets to assist with your creative process.

Progression
This preset helps you modulate from the key of your Main Track progression (Section C).

The top row represents your Main Track Chords.
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The Circle of Fifths on the left allows you to select a destination scale. Once a key has
been selected, your progression is automatically transposed into the Destination Scale,
allowing you to hear your chord progression in a new scale.
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You can change the scale type by clicking the Destination Scale type indicator bar.
If sufficiently similar, Scaler 3 suggests a path from the original scale to the destination
scale.
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Scaler 3 suggests Modulation Pathways consisting of chords that share notes between
the selected scale and the destination scale, creating a smoother and more musical
transition.




Create Page > Modulation 55

Secondary Scale

This preset helps you modulate from your currently selected scale into a second scale.
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The circle of fifths on the left allows you to select a destination scale.

Once selected, the bottom row populates with the diatonic chords of the destination
scale.

If sufficiently similar, Scaler 3 can suggest a Modulation Pathway from the origin to the
destination scale.

Above the destination scale, the secondary dominant path to the chord is displayed. You
can use the < > buttons to cycle through and view the secondary dominant and
predominant chords for any chord in the scale
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Modal Interchange

This preset helps you find chords to borrow from a relative mode.
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Your selected scale is displayed at the top of the Section B Header, with its related
modes shown in rows below.

Each row represents a mode from the same scale family, displaying its corresponding
chords as triads by default.

You can quickly audition these chords with different extensions—7ths, 9ths, 11ths, or
13ths—to explore richer harmonic variations.
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Mediants

This artist-curated preset helps you generate mediant chords starting from any chord of
the currently selected scale, enabling stylistic and subversive chord progressions.

S Scaler3 B = No Preset

Current Scale C Major scale

Main Track

Clicking on a chord generates a new line containing its mediant chords.
A mediant chord is a minor or major third above or below the root of your chord.

For example, from a C chord, Scaler 3 will generate the following chords:
* G# Min / G# Maj - One major third below C
* A Min / A Maj - One minor third below C
« D# Min / D# Maj - One minor third above C
* E Min / E Maj - One major third above C

You can stack up to three lines of mediants to keep moving further by thirds.
The last chords played are shown at the bottom, allowing you to explore and copy your
new chord progression to a new or existing pattern.
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Neo-Riemannian

This preset, based on the Neo-Riemannian theory, allows you to create chord
progressions using specific transformations based on harmonic proximity.
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Drag a chord into each slot to generate related chords.

The Minimize Movement option will try to maintain the number of voices and reduce the
amount of movement between chords.

The Triads Only option will simplify all chords to triads, ignoring the original voicing of the
chord.

With Select on Click enabled, clicking on a chord from a previous row will add it to the
next available row,
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Explore

The Explore page in Scaler 3 offers a fresh way to compose and explore chords, built
around chord constellations based on specific genres and moods. It includes intuitive
visual aids to help you navigate and create progressions. Unlike Chord Sets, which are
pre-composed with a fixed order, duration, and scale, Explore provides a flexible palette
of chords. Each constellation has a preset tonal center, with a dynamic scale that adapts
to the last played chord, allowing for more creative and intuitive composition.
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Explore Presets
Each chord constellation in Explore is curated around specific musical genres and moods
* Genre — Select a preset based on various musical genres.
* Mood - Adjust the mood of the genre preset to your taste by applying a
bright, dark, or neutral mood.

Constellation Key/Tonal Center
The key or tonal center of each preset is represented by the lower-middle chord in the
constellation.

The top-center chord represents the relative minor or major of the root chord in the
lower-middle.
* Chords near the center are the strongest, ‘safe’ diatonic chords (e.g., I, II, IV, V, VI).
* Chords around the outer edge are more adventurous, featuring non-diatonic
chords with colorful extensions.

Left and Right Hemispheres
* Chords on the left are typically darker, more minor-focused.
* Chords on the right are typically brighter, more major-focused.
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Dynamic Scale

The default mode in Explore is Dynamic Scale, where the current key or scale
automatically changes based on the last played chord. This is reflected in the Dynamic
Scale indicator bar, and the colors of the chords update to match the selected chord and
its associated dynamic scale.

Deactivating Dynamic Scale mode activates Fixed Scale mode, where the chord colors
remain fixed based on the Current Scale indicated in Section B. The dynamic scale is still
displayed in the Dynamic Scale indicator bar to help you choose an appropriate scale.
For example, if C Major is selected but a C minor preset is played, the dynamic scale will
show why the chords may not align with the current scale.

Additional Controls
* Bind incoming MIDI notes to the Explore chords.
* Lock Explore chords to the Current Scale.
* Transpose the entire constellation up or down by semi-tones.
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In the above image, the current scale is C Mixolydian mode. The selected Explore genre preset is Techno, and
the Mood preset is Neutral. Dynamic Scale mode is enabled. Incoming MIDI notes will trigger Explore chords, as
Bind is active. Explore chords have been locked to the current scale, and hovering over the chord constellation
has revealed the ‘Dark Side’ and ‘Light Side’ indicators.
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Colors

The Colors Page in Scaler 3 lets you enhance basic triads from your selected scale with
harmonic variations, adding richness and expressiveness to your chords.

Chords are presented across 5 rows, each offering different extensions, voicings,
substitutions, inversions, or variations.
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Use the Colors Menu to select different chord variations for each row.
Tip: Quickly scroll through different colors using the previous/next buttons.

G# min... A# min7 D maj7(... E# dim7 F# maj7

ies ii7 iii 7 7 Vous vie Vil

r Extensions

Voicings 7ths
Variations Sths
Substitutions 11ths

Inversions 13ths

Suspended

6ths & 7ths

Minor 7ths & 9ths

Suspended 4ths, 7ths & 9ths

The image above displays the Colors Menu, which appears when clicking the Color Indicator next to any given
row
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You can also:

1. Adjust the octave for each row of chords.

2. Audition chord variations by clicking the Play button or selecting individual chords.
3. Bind incoming MIDI notes to any row.
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Sketch

The Sketch page lets you build, organize, and refine multiple chord progressions in one
place. Experiment with up to seven different progressions, making it easy to sketch out
and structure different sections of your composition.
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Drag and drop chords onto a progression row.

Tip: Right-click a chord or multiple chords anywhere in Scaler 3 to add it to one of the
seven Sketch progressions.

Use Suggest Mode to generate a unique chord progression with the pattern fill feature.
Apply Motions to your progressions (See: Arrange > Motions for details).

Audition progressions sequentially with the Autoplay button.

Bind incoming MIDI notes to any progression.

Use Keyswitches to trigger different progressions on the fly.
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Arrange Page
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Overview

The Arrange Page provides a multi-track environment where you can layer instruments,
shape performances, and refine your composition — all based on the active chord
progression in your Section C Main Track.

You can adjust the layout by resizing the Track Header — drag its upper border up or down
to allocate more space to the Arrange Sequencer or the MIDI Editor/Mixer section based
on your workflow needs.

In the image below, the Main Track is selected, so the Track Header displays “Main Track.” If a Motion Track

were selected, the header would display its name instead. This image also highlights how to adjust the Arrange
Page layout.

A

Playback Shortcuts
Spacebar plays/pauses

e Return restarts playback
(may differ in DAW Sync Mode, as playback is controlled by your DAW’s transport)

0%
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Main Track

Harmonic Foundation

Chords in the Main Track (Section C) serve as the harmonic foundation for additional
musical parts, or “Motions.” The key of the Main Track determines the key signature of any
added tracks, enabling seamless compositional experimentation while maintaining
harmonic cohesion.
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Synchronicity Across Your Composition

When you change a chord note in the Main Track via the MIDI editor, effectively making

a new chord, Motions immediately adjust to the new harmonic structure, allowing

for fluid creative exploration. Similarly, if a chord or chords in your Main Track are
modified elsewhere in Scaler 3, all connected parts will automatically update to maintain
harmonic consistency.

In the image below, the first chord of the Main Track is being replaced with a D minor chord via drag and drop.
This update automatically adjusts any Motions to D minor, replacing the previous F major chord.

MAJOR 15T HAPPY - LIGH
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Arrange Page Header

From the Arrange Page Header, you can:

Arrange D Harmonic Minor scale

Add tracks using the + button in the top left. This will open the Motion browser.
View the current scale.

Toggle the Scissor Tool on/off to split chord or MIDI clips.

Toggle the Mute Tool on/off to silence selected clips without deleting them.
Adjust the sequencer division resolution to control clip length and snapping
behavior (e.g. 1 bar, 1/2 bar, etc.)

aprebd =

Use the Scissors Tool to slice MIDI clips in your Arrangement.

The grid resolution setting determines the smallest division at which clips can be sliced.
For example, with a division resolution of 1/4, a 1-bar MIDI clip can be sliced into four
equal parts. This allows for precise, on-the-fly editing of your arrangement.

S Scaler3 m

Arrange

Main Track

Note that in the image above, the track header has been dragged down to create more space for the tracks in
the Arrangement sequencer. Additionally, the grid resolution is set to 1/4.
-()= If you have a single Motion Clip and want it to retrigger with each chord
¥ change, use the scissors tool to slice it into multiple clips that align with your
chord progression. Motions will retrigger at the start of each clip instead of
following the chord changes in Follow mode. For more on Perform Modes in
Scaler 3, see Header Section > Settings Menu > Playback Menu.
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Motions

Motions in Scaler 3 transform static chords into expressive, editable MIDI clips that react
in real time to your selected scale and chord progression. Developed by professional
musicians, they provide dynamic movement, rhythm, and human-like variation to your
compositions.
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Motions are divided into Articulations and Expressions.

Articulations include Arpeggios, Passages, Strumming, Chord Follow, Bass Follow, Divisi,
and User.

Expressions encompass Performances, Melodies, Phrases, Bass, Strummed Sequences,
Rhythms, and Sequences.

Once added, Motion clips can be freely edited, rearranged, and customized to fit your
arrangement.
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Motions Browser

The Motion Browser can be accessed by selecting the + button in the Arrange Page
Header. Once a Motion is selected, using this route will create a motion track.

Motions

All Arpeggio Passage 1

Favourites 3 > Passage 2

Strumming Passage 3

Expressions Chord Follow Passage 4

Moods Passage 5

Genres Passage 6

Passage 7

Passage 8

You can also access the Motion Browser via the Global Controls (see Global Controls >
Main Track Motions) or the Sketch Page (see Create Page Chapter > Sketch).

Browse motions by category or filter:

¢ All - A list of all Motions.

* Favourites — Access Motions you’ve marked as favourites. Tip: Select the heart
button next to a chord set to add it to your favourites list.

e Articulations - Arpeggios, Passages, Strumming, Chord Follow, Bass Follow.

¢ Expressions — Performances, Melodies, Phrases, Bass, Strummed Sequences,
Rhythms, Sequences.

* Moods - Filter motions based on emotion or feel.

e Genres - Filter motions by musical genre.

You can also use the search field to find specific Motions.
To select a Motion, single-click its title, or double-click the MIDI note visualization.

Tip: Click and hold the MIDI note visualization to audition it before making a selection.
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Motion Tracks

After clicking the + button in the Arrange Page Header and choosing a Motion, a track will
be created.

Arrange

Main Track

Motions

Up
Passages
Strumming
No Track il
Expressions Chord Follow Up/Down Repeat
Moods Down/Up

Genres Down/Up Repeat

Doubled Up

Arrange

Main Track

Arpeggio

Up/Down

The two images above illustrate the Motion Track creation process.

In the first image, the user clicks the + button to open the Motions browser and selects an

Arpeggio articulation. In the second image, an Arpeggio track has been created, with the track header
displaying the selected track type. Additionally, the Arpeggio track now has a dedicated channel in the Mixer.
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Track types are determined by the Motion selected, and once created, cannot be changed
to a different track type. For example, if an Arpeggio track is created, only Arpeggios can
be used on that track. To use a different Motion type, you must create a new track.

However, you can change to different motions of the same type on an existing track:

o~
o

Arpeggio .

v Main Track Arpeggio
I\

Up/Down

® O O
@ o

1. Select the track or motion clip.

a. Use the previous or next buttons on the current motion indicator at the top of
the MIDI Modifiers section.

b. Or click the magnifying glass in the MIDI Modifiers section to open the
Motion Browser.

Note: Only motions of the same type will be accessible. As mentioned above, to select a
different motion type, create a new track.

-()= Manage tracks quickly by using the three-dot menu on a track. From there, you
“ can delete or rename a track. Motion tracks can also be reordered by clicking
and dragging them within the track lanes.
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User Track

The User Track in Scaler 3 lets you capture your own musical ideas or program them
directly, giving you complete control over melodies and rhythmic patterns. It allows you
to layer custom MIDI over your Main Track chords and motions, helping you sketch ideas,
experiment with new musical phrases, or build complex, custom arrangements.
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Recording Live MIDI

1. Create a User Track
Click the + button, then choose User Track from the Articulations category.
2. Enable MIDI Input Monitoring
Click the header of the User Track to arm input monitoring. This allows you to hear
your instrument through Scaler before you start recording.
3. Arm for Recording
Click the User Track’s record button to prepare it for recording.
4. Start Recording
Once armed, start recording by clicking either:
- The User Track play button (visible when the track is record armed).
- Scaler’s main play button.
- Your DAW'’s play button if DAW sync is enabled.
5. During Recording
- A 1-bar metronome count-in plays before recording. Enabling the metronome from
Scaler’s Header section keeps it playing throughout the recording.
- MIDI overdub is employed, so recording over an existing section won’t
overwrite the notes; instead, new notes will be added to the existing recording.
- Recorded MIDI clips automatically snap to a default 1/16 quantise, keeping your
performance rhythmically aligned. You can adjust quantization and resolution
settings via the MIDI Editor’s header when recording has stopped.
- Clips are auto-cropped to the current division setting, trimming any excess silence.
- You can record Scaler’s MIDI output directly, including Chord Triggers and
Keys Lock notes.
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Programming User Track MIDI Clips

1. Create a User Track
- Click the + button, then choose User Track from the Articulations category.
- An empty MIDI clip will be added to the track.
2. Open the MIDI Editor
- Double-click the MIDI clip, or single-click the clip and navigate to the MIDI Editor
to open it for editing.
3. Draw Your Notes
- Use the Pencil tool to add notes.
- Refine with other available MIDI editor tools.

For more detailed MIDI editing instructions, see Arrange Page > Working with MIDI.
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Scenes

Scenes in Scaler 3 let you group chords clips and MIDI clips into self-contained musical
sections that can be freely arranged, duplicated, and triggered. They make it easy to
experiment with different song structures, variations, and arrangements—much like
building verses, choruses, or bridges in your composition.
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Creating Scenes

1. Click and drag (lasso) to select one or more Main Track clips — these can be chord
clips only, or chord clips combined with motion clips.
Note: At least one chord clip must be included in the selection to create a Scene.

2. The Create Scene button appears above the selection. Click it to group the selected
clips together.

3. Scenes can also be created via the right-click menu - Add to New Scene, available
from various pages in Scaler 3.
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Managing Scenes

* Resize a Scene by dragging its edges.
* Expanding a Scene allows additional clips to be added to it.
 If a Scene is expanded over other clips or Scenes, those clips are absorbed into
the expanded Scene.
» Contracting a Scene trims or removes any clips that fall outside the new boundary.
* Move a Scene freely across the Arrange Page to change its position.
* If you drag a Scene over another Scene, the existing Scene will be split at the point
where the moved Scene is placed.
* Right-click a Scene name to Rename, Duplicate, or Delete it.
* Choose Delete Scene and Content from the same menu to remove both the Scene
and its clips.
* Use Set Loop Area from the right-click menu to define the playback region for
a Scene.

S Scaler3 @ My Cool New Song
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Binding Scenes

On the Browse Page, you can bind individual Scenes to MIDI input. When triggered, only
the chords within that Scene will play back.

With Bind enabled, click a Scene’s BIND button to assign only the chords from that
Scene to incoming MIDI notes.

Main Track Brass Ensemble
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Multi-Channel MIDI Out

Scaler 3 supports flexible MIDI output routing, allowing each track to be assigned to a
specific MIDI channel, disabled entirely, or sent directly to an external MIDI device. This
enables both multi-channel routing within a DAW and real-time performance with
hardware instruments or external software.

This is accomplished via the three-dot menu in each track’s header.
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External MIDI Output — Send MIDI directly from each Scaler 3 track in the Arrange Page to
any MIDI Qutput Device, enabling real-time performance without routing through a DAW.

MIDI Output Channel — Send MIDI to separate channels within your DAW or external
device, providing precise control over multi-track routing and playback.

This channel assignment flexibility makes it possible to route MIDI data from tracks in
Scaler 3 to one or multiple MIDI tracks in your host DAW, which is helpful for a number of
reasons:

* Perhaps you’d prefer to host instrument plugins in your DAW rather than Scaler
to take advantage of certain DAW routing or processing features.

» Or to utilize software instruments in proprietary plugin formats e.g. Ableton Live
devices or Logic Pro instruments, which Scaler 3 does not natively support.

* Or to route MIDI externally to hardware devices using your DAW’s MIDI routing
capabilities.

Note: The process for configuring MIDI routing varies depending on your host DAW.
For guidance, refer to the Scaler 3: MIDI Output — DAW Routing Guide, which includes
setup tips for Ableton Live, Logic Pro, Reaper, Cubase/Nuendo, Studio One, FL Studio,
Bitwig Studio, and Pro Tools.



https://scalermusic.com/wp-content/uploads/2025/06/Scaler-3-MIDI-Output-DAW-Routing-Guide.pdf
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Working with MIDI

Scaler 3 offers two methods for editing MIDI: via the MIDI Modifier Sidebar or the MIDI
Editor.
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MIDI Modifier Sidebar — This sidebar lets you make bulk changes to MIDI clips,
adjusting multiple notes at once through various controls.

MIDI Editor — Clicking a chord or motion clip opens the MIDI Editor, displaying the
selected clip’s notes for manual adjustments.

Editing Modes
Scaler 3 provides two modes for MIDI editing:

e Locked Mode (default): The Motion MIDI clip stays linked to the Main Track,
automatically transposing as the main track chords change and reacting to
Motion controls like arp speed or strum direction.

* Unlocked Mode: The Motion MIDI clip is detached from the main track, allowing
full manual editing of notes in the piano roll. However, Motion controls via the
MIDI Modifier Sidebar are disabled, and the clip no longer reacts to chord changes.

Tip: quickly lock detached MIDI back to the key of your Main Track chords by selecting

Re-Attach.

Melody ) eyboard View: Chromatic
\ 4
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MIDI Modifier Controls
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Note that in the image above, the track header has been dragged up to it’s maximum to expose
all available MIDI Modifier controls for the selected Motion MIDI clip.

MIDI Modifier Controls vary across different motion types and the main track
chord clips, but share many common parameters.

Below are the controls grouped into shared controls (applicable across most
motions) and motion-specific controls.

Modifier Control  Effect on MIDI Clip

Octaves Transpose by octaves (drag up/down)

Transpose Transpose notes of the selected clip (drag up/down)

Density Increase/decrease note density of the selected clip (drag up/down)

Rotate Resolution Select rotate resolution for the selected clip (opens a menu)

Voicing Select a voicing preset for the selected clip (opens a menu)




Arrange Page > Working with MIDI 78

Motion-Specific Controls

Modifier
Control

Octave
Semitone
Timing
Note
Length
Resolution
Direction
Profile
Alternative

Play Mode

Play Style

Effect on MIDI Clip

Transpose the selected chord up/down in octaves

Transpose the selected chord up/down in semitones

Select an arpeggio timing resolution (opens a menu)

Select an arpeggio note length (opens a menu)

Select a passage resolution/speed (opens a menu)

Select a motion pattern (drag up/down)

Select a strum profile (opens a menu)

Select a strum variation (opens a menu)

Choose between Chord or Scale Expression play modes

(Bass) or Select an expression play mode (Sequences)

Select an expression play style (opens a menu)

Applicable Motion
Types

Main Track Chords

Main Track Chords
Arpeggios

Arpeggios

Passages, Performances,
Melody, Phrases, Bass,
Sequences

Strumming, Strummed
Sequences

Strumming, Strummed
Sequences

Strumming, Strummed
Sequences, Rhythms

Bass, Sequences

Sequences
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MIDI Editor

Scaler 3’s MIDI Editor presents a familiar piano roll format, allowing you to edit MIDI clips
just like in most DAWs.
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MIDI Editor

The MIDI Editor includes a range of tools and visual aids for intuitive MIDI
editing and programming.

iew: Chromatic

1. Speaker Icon: Toggle on to hear MIDI notes when selected or off to mute them while
editing.

2. Keyboard View: Visualizes notes in relation to the selected scale, with three modes:
* Chromatic: No highlights.

* Scale Notes: Highlights notes in the selected scale.

* Chord Notes: Highlights notes from the current main track chord progression.

3. Tools:

+ Selection Tool: Drag or resize notes.

* Eraser Tool: Delete unwanted notes.

* Pencil Tool: Draw in new notes.

» Scissors Tool: Split notes according to the division setting.

4. Velocity: Adjust the overall or individual note velocities by sliding up or down.

Motion tracks only:
5. Humanize — Add slight variations to velocity and timing for a more natural feel.
6. Keyboard Icon - Toggle on to overlay main track chords for easy reference
when working with Motion MIDI notes.
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Mixer

The Mixer in Scaler 3 provides full control over your tracks, allowing you to balance,
shape, and refine your arrangement. Each track features independent controls for
volume, solo, mute, pan, and plugin assignments, supporting both internal instruments
and third-party plugins.
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Track Controls

Each track in the Mixer includes:

» Track Name Display — Identifies the track, such as Main Track, a Motion Track Type
(e.g., Arpeggio), or Master

« Solo (S) & Mute (M) — Isolate or silence individual tracks

* Pan Control — Adjusts stereo positioning

* Volume Slider — Sets the track level

* Power Button — Enables/disables sound or insert slots

* Instrument and Effect Editors (dial icon) — Opens instrument or effect-specific
parameters
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Loading Sounds

To load a sound or instrument, click a sound slot within a track channel to open the
Sounds Browser.

O

Felt Piano

None
None

None

In the above image, a StrummedSequences Motion Track is selected with the Felt Piano internal sound loaded.
The Felt Piano is the default sound assigned when a new track of any type is created.

Sounds

No Instrument
Favourites Internal Sounds - 808 Bass
Internal Sounds Internal Sounds - Bass Guitar
Instruments Internal Sounds - Chorus Bass
Manufacturer Internal Sounds - FM Bass
Internal Sounds - Jazz Bass
Internal Sounds - Orchestral Bass
Internal Sounds - Retro Bass

Internal Sounds - Saw Bass

Internal Sounds - Slap Bass

The second image shows the Sounds Browser, which pops up after clicking a sound slot on a channel strip or in
the Main Track Sounds Panel in Section C.
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The Sounds Browser organizes sounds and instruments into categories alongside
filtering options:

e AU - View all available instruments

* Favourites — Quickly access your saved instruments Tip: Click the heart
button next to an instrument to add it to your favourites list.

* Internal Sounds - Scaler 3’s built-in sounds, categorized by Piano, Synth,
Guitar, Hybrid, Orchestra, and Bass

e Instruments - All third-party instruments available on your system

* Manufacturer - Filter third-party instruments by their developer

You can also use the Search field to quickly locate an instrument by typing its name.

Sounds

All Algonaut Komplete Kontrol (VST3)

Favourites Apple Kontakt (AudioUnit)

Internal Sounds Audiomodern Kontakt (VST3)

Instruments BEATSURFING Kontakt 5 (AudioUnit)

DISTRHO Kontakt 7 (AudioUnit)

Plugin Alliance Maschine 2 (AudioUnit)

Plugin Boutique Maschine 2 (VST3)

Scaler Music Massive (AudioUnit)

Sonic Charge Massive (VST3)

Single-click to load your selection.

82
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Adjusting Sounds

Once a sound has been loaded onto a track, use the Sounds Editor button to shape
internal or third-party sounds and instruments.

StrummedSequences

@)

( Felt Piano

() None

& None

In the above image, the Sounds Editor button is highlighted. The Felt Piano internal sound is active on the
track, so selecting the Sounds Editor button opens the Internal Sound Settings window (as shown in the image
below).

Note: If a third-party instrument were active instead, clicking the Sounds Editor button would open the
third-party instrument in a separate window.

Sound Settings

FILTER REVERB

Internal Sound Settings:
* AMP - Adjusts Attack, Decay, Sustain, and Release (ADSR)
* FILTER - Controls the Cutoff frequency
*+ REVERB - Adjusts the amount of reverb applied
* DELAY - Adjusts the delay effect level

For third-party sounds and instruments, the Sounds Editor opens the plugin in a separate
window, allowing you to tweak its parameters directly. You can keep the window open
alongside Scaler 3 for a seamless composition and sound design experience. The window
can be minimized or closed at any time.
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Loading Effects

To load an effect, click an empty effect slot within a track channel to open the Effects
Browser.

O

Felt Piano

None
None

None

In the above image, a Strummed Sequences Motion Track is selected with no effects inserted, as indicated by
“None” on each empty effects slot. Clicking on an available effects slot opens the Plugins window (as shown in
the image below).

The Plugin Browser organizes effects into categories with filtering options:

e All - View all available effects

* Favourites — Quickly access your saved effects. Tip: Click the heart button next to
an effect to add it to your favourites list

e AudioFX - Browse third-party audio effects available on your system

e Manufacturer - Filter third-party effects by their developer

Effects

WUIK\WUdK

All Crystallizer (AudioUnit)
Scaler Music

Favourites Crystallizer (VST)
Slate Digital

AudioFX Crystallizer (VST3)

Soundtheory
Decapitator (AudioUnit)

Decapitator (VST)

Supertone

Decapitator (VST3)

Tokyo Dawn Labs
Devil-Loc (AudioUnit)
Valhalla DSP, LLC
Devil-Loc (VST)
Venn Audio
Devil-Loc (VST3)
Xfer Records
Devil-Loc Deluxe (AudioUnit)

Youlean

You can also use the Search field to quickly locate an effect by typing its name.

Single-click to load your selection.
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Adjusting Effects

Once an effect has been loaded onto a track, the Effects Editor opens the plugin in a
separate window, allowing you to tweak its parameters directly.

StrummedSequences

@)
L

Felt Piano

EchoBoy
\[o]y 1]

None

You can keep the window open alongside Scaler 3 for a seamless composition and mixing
experience. The window can be minimized or closed at any time.
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The above image shows the Effects Editor open in a separate window, allowing for direct
parameter adjustments.
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Instrument Panel

The Instrument Panel in Scaler 3 provides an interactive way to visualize and play sounds
using a keyboard or guitar fretboard interface. These interfaces help identify whether
notes match your selected scale, show key bindings and keyswitches, and allow for chord
editing. Both the keyboard and fretboard can be expanded or collapsed to suit your
workflow.
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Keyboard Visualization

The Keyboard is visible by default, but can be collapsed by selecting the Keyboard Display
button.

It provides a visual reference for scale notes, chord voicings, and key mappings.
It dynamically updates based on your selected scale and Bind MIDI settings.

* Scale Notes — Marked with blue indicators

» Active Keys — Highlighted in blue when within the selected scale, or grey if outside
the selected scale

* Locked Keys - Display a lock icon, indicating restricted access

* Disabled Keys — Marked with a cross icon

* Bind Region - Highlighted in yellow, showing active chord binding areas

+ Keyswitches — Shown in green, triggering specific functions or variations

* Feature-Specific Areas — Indicated in purple for contextual functionality

You can adjust the visible range of the keyboard by scrolling with your mouse wheel,
allowing you to view lower or higher octaves
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Fretboard Visualization

To display the Fretboard Visualization, select the Fretboard Display icon.

The fretboard helps you find notes, scales, and chords on fretted instruments, making it
easier to navigate the neck of your instrument.

Scaler 3 supports over 25 tunings across multiple instruments, including guitar, bass,
ukulele, and banjo.

Guitar Settings

With the Fretboard Visualization open, select the gear icon to access Guitar Settings.

Guitar Settings

Standard Open C
Custom > Open D
Regular Open D Minor
Bass Open G
Baritone Open G Minor
Open A
Modal D
Modal G

Drop C
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Within the Guitar Settings, you can choose from a variety of tunings, organized into
categories such as:

Standard
Custom
Regular
Bass
Baritone
Other
User

Chord Charts

The Chord Chart feature displays chord diagrams for any selected chord in Section C.
These diagrams provide a simplified representation of the guitar neck, indicating finger
placement and playing position. To access chord charts, select the Chord Chart button.

How to Read Chord Charts

Vertical lines represent the guitar strings, with the lowest (bass) string on the left and
the highest string on the right.

Horizontal lines represent the frets, with the topmost line indicating either the
nut or a specific fret (if a number is displayed).

Circles and bars indicate where to place your fingers. Numbers inside the
circles correspond to finger placement:

* 1= Index finger

* 2 = Middle finger

* 3 = Ring finger

* 4 = Little finger

O (open) and X (muted) symbols appear above the strings:

* O means the string should be played open (not fretted).

* X means the string should be muted and not played.

Chord Charts
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Global Controls

The Global Control panel includes tools to enhance your progression on the Main Track,
offering controls for humanization, note mapping, voice grouping, and transposition, all
designed to refine the performance and expressiveness of your composition.
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Transpose your main track chord set up or down by semitones.

Main Track Motions

Enable and browse Motions to add expressive movement to your Main Track chord
progression. For a detailed explanation of Motions, see Arrange > Motions.
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1. Toggle Motions on or off using the circle button.

2. Open the Motion Browser by clicking the name of the currently selected Motion.
3. Previous / Next Navigation — Quickly scroll through Motions.

4. Adjust Motion resolution/speed by dragging up or down.
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Humanize

Add a natural feel to Motions by introducing slight variations in velocity and timing.

1. Toggle Humanization on or off.
2. Click on the currently selected profile to open humanization, quantization, and
swing options:
a. Velocity — Randomizes the dynamics of each note.
b. Timing — Randomizes the start time of each note.
c. Both — Applies randomization to both velocity and timing.
d. Quantize — Aligns notes to a grid of the selected size for tighter timing.
e. Swing — Shifts certain notes slightly off-grid to create a more
expressive, grooved feel.

Adjustments
3. Select a Humanize/Quantize division setting by clicking the division setting indicator.
4. Adjust the Humanization amount by dragging the percentage value up or down.
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Keys Lock

Map keyboard keys to the notes of any scale or chord, making it easy to play melodies
while staying in key.

v

Scale Notes Only

1. Toggle Keys Lock on or off.
2. Click to open the Keys Lock Modes Menu and select from several available modes.

Keys Lock Modes

» Scale Notes Mapped - Transpose out of scale notes to notes of selected scale.

» Scale Notes Only — Locks all notes to the selected scale. Out-of-scale notes
are redirected to the nearest fitting note, ensuring you always stay in key.

» Scale White Keys — Maps any scale to the white keys, deactivating black keys.
The scale’s first degree is placed on C, allowing you to play it as if it were C Major.

* Chord Notes — Locks a predefined keyboard area to trigger notes from the last
chord played. The lowest note of the chord is placed on C, while black keys are
deactivated. This makes it easy to create simple melodies while triggering
different chords.

* Chord Extensions — Similar to Chord Notes, but expands the playable range to
include extended chord tones. The root of the extended chord is placed on C,
allowing for more complex melodies.

* Chord Scales — Works like ‘Scale White Keys’ option except a new scale is
selected automatically based on the last triggered chord
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Voice Grouping

Group notes in a specific range to allow for smooth changes between chords.

v v

® Voice Grouping Dynamic

1. Toggle Voice Grouping on or off.
2. Click to open the Voice Grouping Profiles Menu and select from several
available profiles

Voice Grouping Profiles

Dynamic

Allows for smooth changes between chords by automatically grouping notes
around the tonal center of the currently selected scale. This prevents big jumps in
intervals when moving from a lower diatonic chord to a higher diatonic chord,
such as | > vi (for example, from a C Major to an A Minor chord).

The Dynamic Grouping preset plays the bass note two octaves below the tonic, then
automatically chooses the best inversions of each played chord to minimize their
respective distance to the tonic of the scale.

The upper extensions of the chord (9th, 11th, 13th) are grouped in a second octave

unless the distance with the tonal center becomes too significant, in which case they are
inverted and placed in the first octave.

Dynamic C1-B2, C2-B3, C3-B4

Automatically adapts voicing to play chords within the defined range. Typically used for
restricting the range of octaves when using sample libraries that only play across certain
octaves.

Open Voicing
Automatically adapts your chord to play an open voicing.

Guitar Voicing
Adapts the voicing to play a version adapted to the guitar neck.

Drop2/Drop3/Drop4/Drop2&3
Classic guitar voicings where the 2nd (3rd or 4th) voice is dropped (lowered) by an octave.

Extracted Voicing

After extracting the voicing from a chord, you can use Voicing Lock to preview other
chords as if they were played with the same voicing. Scaler 3 automatically adapts the
source voicing onto the chord, matching the playing position and minimizing the distance
between each voice. Try creating your own preferred voicing by editing a chord, extracting
its voicing, and applying it to all chords.
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Scaler 3 for iPad

All core functionality of Scaler 3 for iPad is unchanged from Scaler 3 for desktop; only the
interaction methods differ. This section describes the touch-specific ways you adjust
parameters, resize the instrument panel, open context menus, resize clips/notes, and
move or copy chords on the iPad.
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Adjusting Parameters

There are two primary ways of interacting with parameters in Scaler 3 which differ
between desktop and iPad.

Desktop Behaviour iPad Behaviour

Scroll mouse wheel Tap the parameter - a pop-up appears with +/- buttons and a scrub
lane.

If a parameter would normally require scrolling on the desktop (e.g. MIDI Modifier
Controls, Section B octave adjust, etc.), tapping it opens a visual pop-up that makes
precise adjustment easy. You can still scroll the value by dragging up or down however
the pop-up simply provides an alternative, easy-to-see interface.
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Pop-up interaction

-
.

Tap the parameter you want to change.
2. A parameter pop-up opens directly above the control, showing:
* Parameter name
» Parameter value — Double-tap the value to reset it to default.
* </ > buttons - Increment or decrement the value in single steps.
* Scrub lane — Drag left to decrease, right to increase.
3. Tap outside the parameter pop-up to confirm the new value and dismiss the
pop-up.

S| Scaler3 B Pepper 104

In the image above, the Length parameter has been tapped, opening the parameter pop-up. The pop-up
displays the current value (110), increment (< / >) buttons, and the scrub lane for adjusting the parameter.

Direct numeric entry for broad-range parameters

Some parameters have a very wide numeric range (e.g., Tempo). For these you can
double-tap the parameter to open the iPad keyboard and type the exact value you need.

e Supported parameters: Tempo, Time Signature, Key Root, Octave, etc.

¢ Unsupported parameters: Controls that have a limited set of discrete values
(e.g., MIDI Modifier Controls range -7 ... +7). Double-tapping on such controls only
opens the pop-up, not the keyboard.

Example (Tempo)

1. Double-tap the Tempo field.

2. The iPad numeric keyboard appears.

3. Enter the desired BPM (e.g., 128) and tap Return or Done. The value updates
instantly.
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Instrument Panel Controls

Resizing the Instrument Panel

At the bottom of the interface is the Instrument Panel, which displays either a piano
keyboard or a guitar fretboard. You can vertically resize the panel to better suit
performance on smaller screens.

1. Locate the divider bar that sits directly above the instrument panel.

2. Tap and hold the divider bar.

3. Drag upward to increase the panel’s height, or drag downward to decrease it.
4. Release to lock the new size.

20)% The panel can only be enlarged up to fill around half of the screen height.

Keyboard Display Settings

A keyboard icon sits in the lower-left corner of the interface. Tapping it opens a menu
that provides quick access to keyboard-specific options.

Opening the menu

-

Tap the keyboard icon (lower-left).
2. The Keyboard Settings menu appears, containing three sections:
» Keyboard Size - three options: Large, Medium, Small.
» Octave — two options: Octave — (transpose down one octave) and
Octave + (transpose up one octave).
* Collapse Keyboard — hides the instrument panel entirely.
3. Tap elsewhere on the screen to close the menu after you’ve made your selection.

Using the options

» Keyboard Size — Choose Large, Medium, or Small to horizontally resize the keyboard,
showing more or fewer keys on the screen. This helps maintain playability across
different iPad sizes.

* Octave - / Octave + — Shifts the on-screen keyboard up or down by whole octaves.

» This changes only the visible pitch range of the keys; the octave of any chord you
insert or play elsewhere in Scaler 3 remains unchanged.

* Collapse Keyboard — Selecting Collapse Keyboard removes the instrument panel
from view. The panel can be restored by tapping either the keyboard icon or the
guitar icon in the lower-left corner.

Note: The guitar icon works the same way - if the instrument panel is hidden, tapping the
guitar icon restores the panel in guitar-fretboard mode.
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Right-Click Menus
Multi-Touch Gesture

The iPad has no mouse, so a right-click is simulated with a brief press + second-finger
tap gesture.

1. Press and hold the target item (one or multiple chords, scene header, etc.) for less
than one second without moving it.

2. While still holding the item, tap anywhere else on the screen with a second finger.
The right-click context menu appears.

Important: Holding the press for a longer duration (=1 second) may switch the item into
resize mode (see the next section) instead of opening the menu. Keep the first press
short if you intend to open a menu.
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In the image above, the E min7 chord is briefly pressed (indicated by the green circle). While holding the chord,
a second-finger tap elsewhere on the screen (indicated by the purple circle) opens the right-click context
menu.
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Resizing Chords & MIDI Notes

On the desktop you hover the mouse over the left or right edge of a clip or note; the
cursor changes to a resize arrow and you drag to lengthen or shorten. The iPad replaces
hover with a long-press gesture.

1. Press and hold a chord or MIDI note for =1 second without moving it.

* A white border appears around the selected item, indicating resize mode.
2. While the border is visible, drag the left or right edge of the item to lengthen or
shorten it.

* The item cannot be moved while in resize mode; only the length can be changed.
3. Release to confirm the new length.
4. Tap elsewhere to exit resize mode.

=()- If you accidentally trigger resize mode while trying to move an item, simply

“ release, tap elsewhere to exit resize mode, and try the move again. The white
border is the visual cue that resize mode is active.

$ Scaler3

Arrange

Db maj7/C
vi

MIDI Editor

AR RAR AR RAR AR 01

In the image above, the chord is long-pressed (indicated by the green circle), revealing the white border that
indicates resize mode. The purple circles and arrows show that the chord can be resized horizontally.
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Moving & Copying Chords
Copy vs. Move

Gesture

Move chord(s) Drag and release without  The chord(s) are removed from their original
a second tap. spot and placed only at the new location
(original location is cleared).
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In the image above, the chords and clips are dragged to a new location (indicated by the green circles and
arrow). While dragging, a second-finger tap elsewhere on the screen (indicated by the purple circle) duplicates
the items at the drop location.
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Exporting iPad Presets

It’s easy to transfer presets from Scaler 3 on iPad to macOS or Windows, so you can start
a project on iPad and continue on desktop.

On iPad:

1. After saving or loading a user preset, tap the export button in the top-right corner of
the header and select Export User Preset.

2. Save the preset to a folder accessible from your desktop (e.g. Dropbox, iCloud Drive,
etc.).

On your computer:

1. Copy the preset file into Scaler 3’s Presets folder:
* macOS: /Users/[User Name]/Library/Scaler Music/Scaler 3/Presets
* Windows: C:\ProgramData\Scaler Music\Scaler 3\Presets

(): macOs: The Library folder is hidden by default. In Finder, click Go and hold the
“ Option key to reveal Library. Then navigate to Scaler Music/Scaler 3/Presets.

Windows:The ProgramData folder is hidden by default. Press Windows + R,
type %ProgramData%, and press Enter; or enable Hidden items iN File Explorer
and navigate to C:\ProgramData\Scaler Music\Scaler 3\Presets.
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Appendix

Color-Coding System

Scaler 3 uses a color-coding system to display chords and notes based on their
relationship to the currently selected scale.

Chords

1. Chords with all notes belonging to the selected scale are highlighted in blue.
2. Chords with one note outside the selected scale are highlighted in light blue.
3. Chords with two or more notes outside the selected scale are highlighted in grey.

C maj
|

Notes

1. Notes that fit within the selected scale are highlighted in blue.
2. Notes that are outside the selected scale are highlighted in grey.
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Musical Notation

Scaler uses a compact chord naming convention. The first part of the name is referring to
the most general (non altered) part of the chord.

For example, a min7 chord refers to a minor seventh chord made up of a minor third and
minor seventh above the root.

The second part are alterations applied to the chord. Alterations are optional and
specified between parenthesis. Alterations affect the chord by taking precedence over
the pitches that would normally establish the named chord.

For example, a min7(b5) chord means that the expected perfect fifth of the minor
seventh chord will be replaced by a diminished fifth, the rest of the pitches remain
unchanged.

The third part of the name is the extension. This part is also optional and is separated by
spaces.

For example, a min7(b5) b9 is a minor seventh chord with a diminished fifth to which we
have added a flat nine.
There can be multiple alterations and extensions to a chord.

For example, a min11(b5 #9) is a minor eleventh chord with two alterations on the
fifth and ninth, and a min7 b9 #11 is a minor seventh chord with no alterations but two
extensions a flat ninth and a raised eleventh.
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Troubleshooting

No MIDI Input

Check that your DAW is configured to send a MIDI signal to the track on which you loaded
Scaler. Depending on your software, you might need to select or arm the track you wish
to send MIDI to.

No Audio Input
When using Scaler, check that you have routed the audio signal correctly into Scaler.
When using Scaler Audio, make sure there is audio content playing on the track.

Chord Progression Sounds Different When Dragged into DAW
Most likely you still have ‘Bind’ activated in Scaler 3 so you are effectively performing a
performance. If you are dragging MIDI to your DAW please turn of ‘Bind’ in Scaler 3

Hung/Stuck MIDI Notes
Simply press the MIDI Panic button located in the Header section to cancel any scheduled
MIDI event and reset the state of the keyboard.

Help and Community
See above Introduction > Learning Resources.
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Legal
Scaler End User License Agreement

Permission to use the Scaler 3 software (Software) is conditional upon you (Licensee) agreeing to
the terms of this End User License Agreement (EULA). A license to use Software and Additional
Materials is offered to you by Scaler Music ACN 6333 215 808 (Scaler) only on the condition that
you read and accept all the terms of this EULA and wish to become a licensee of the Software
and Additional Materials. Acceptance will bind you and each of your employees to the terms of the
EULA. By clicking “I Accept”, you will be deemed to have accepted the terms set out in this EULA.
If you do not wish to accept the terms, you must not click “I Accept” and you may not use the
Software or any Additional Materials.

1. License
(a) Pursuant to this EULA, Scaler Music grants the Licensee a non-exclusive, revocable
license to:

(i) use the Software on the basis of a fourteen (14) day trial license (14 Day Trial);

and

(ii) subject to the payment of the License Fee, continue using the Software

following the expiry of 14 Day Trial, subject to the terms and conditions set out in

this EULA.
(b) The Licensee may install the Software concurrently on up to five (5) computers for the
Licensee’s use, but the Software is licensed for use by one (1) person only. An employee of the
Licensee may use the Software in carrying out their duties in their capacity as an employee of the
Licensee, provided that the Software is only used by that employee and no other person (including
the Licensee). For example, if the Licensee is an individual that wishes to use the Software and the
Licensee also has an employee that it wishes to use the Software in carrying out its duties for the
Licensee, the Licensee will be required to purchase a second license for the employee by paying a
second License Fee.

2. License Fee
Following the 14 Day Trial, the Licensee is not entitled to use the Software until the license fee for
the Software has been paid (License Fee). The License Fee must be paid in the amount and in the
manner specified by:

(a) Scaler where the Software is acquired directly from Scaler; or

(b) the authorised distributor of the Software where the Software is acquired

from an authorised distributor of the Software.

3. Additional Materials

This EULA extends to any accompanying documentation, materials and files including, but not
limited to the manual for the Software, audio files, sound libraries, third party licensed content,
bug fixes, updates and improvements to the Software provided by Scaler in conjunction with the
Software (Additional Materials). Where used in this EULA, unless expressly provided otherwise, the
defined term Software shall include the Additional Materials. The Additional Materials may not be
copied, modified or used in any way not contemplated or expressly authorised by this EULA.
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4. Licensee’s Obligations

The Licensee undertakes the following obligations:

(a) to not copy, reproduce, translate, adapt, reverse engineer, decompile, vary or modify the Soft-
ware in whole or in part, except as expressly authorised by this EULA or part Il division 4A of the
Australian Copyright Act 1968 (Cth);

(b) to supervise and control the use of the Software in accordance with the terms of this EULA;

(c) to ensure its employees who have authorised access to the Software are made aware of, and
comply with, the terms of this EULA;

(d) to not provide or otherwise make available the Software or any part of it in any form to any
person other than those referred to in paragraph 4(c);

(e) to not give, sell, lease, assign, license, sub-licence, transfer, distribute, disclose, disseminate or
publish the Software in any form to any other person or attempt to do any of these acts except as
otherwise authorised in this EULA;

(f) to only use the Scaler software in accordance with the manual provided as part of the Addition-
al Materials;

(g) to not develop any derivative or other software program based on the Software;

(h) to only use presets or parts of sound libraries that form part of the Software in the context of
musical arrangements, recordings of arrangements and live performances;

(i) to not extract, copy or produce from the Software any single preset, sound or

MIDI files or any assembly of presets, sound or MIDI files for resale, commercialisation or any oth-
er form of distribution or create derivatives of any presets, sound or MIDI files from the Software
(including exporting Additional Materials and selling, commercialising or distributing as sample
libraries); and

(j) to not use the Software in any way that is illegal or contrary to any laws or regulations, infringes
the rights of any third party or is defamatory of any third party.

5. Warranty
(a) The Licensee acknowledges that the Software and Additional Materials cannot be guaranteed
error or interruption free or otherwise free from infringement and further acknowledges that the
existence of any such errors must not constitute a breach of this EULA by Scaler.
(b) Subject to clause 5(e), Scaler will not be liable for any indirect or consequential loss or damage
arising out of a breach of this EULA or arising out of the supply of the Software and any condition,
warranty, right or liability which would otherwise be implied in this EULA or protected by law is
excluded.
(c) Pursuant to Schedule 2 of the Competition and Consumer Act 2010 (Cth) (Australian Consum-
er Law), liability for breach of a guarantee conferred by the Australian Consumer Law (other than
those conferred by sections 51-53 of the Australian Consumer Law) in respect of any of the goods
or services supplied under this EULA which are not of a kind ordinarily acquired for personal, do-
mestic or household use or consumption is limited:

(i) in the case of goods, to any one of the following as determined by Scaler, the

replacement of the goods or the supply of equivalent goods, the repair of the

goods, the payment of the cost of replacing the goods or of acquiring equivalent

goods or the payment of the cost of having the goods repaired; and

(ii) in the case of services, to any one of the following as determined by

Scaler Music or Plugin Boutique, the supplying of the services again or the payment

of the cost of having the services supplied again.
(d) If clause 5(c) does not apply, the total liability of Scaler for loss or damage of any kind:

(i) arising under this EULA;

(ii) out of or in relation to the Software, its sale, delivery or the way it operates in tort,

contract or in any other cause of action; or

(iii) in any other way, is limited to the amount of the License Fee paid by the Licensee and

any other amounts paid by the Licensee to Scaler under this EULA.
(e) Nothing in this EULA excludes, restricts or modifies any condition, warranty, right or liability im-
plied in this EULA or protected by law to the extent that such exclusion, restriction or modification
would render this EULA or any provision of this EULA void, illegal or unenforceable.
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(f) The Licensee acknowledges that:
(i) prior to paying the License Fee, a reasonable opportunity has been provided, in the form
of the 14 Day Trial Period (irrespective of whether the Licensee utilised the 14 Day Trial Peri
od), to assess the suitability of the Software;
(ii) at no time prior to entering into this EULA has it relied on any representation by
Scaler or any distributor of the Software regarding the Software or the Additional
Materials which the Licensee has not been able to verify, or had the opportunity to verify or
investigate (including by way of the 14 Day Trial), independently;
(i) it is not obliged to continue use of the Software beyond the 14 Day Trial Period; and
(iv) prior to paying the License Fee, it has been given a reasonable opportunity:
(A) to satisfy itself that the Software and Additional Materials corresponds with any representation
made by Scaler Music or Plugin Boutique; and
(B) to examine Software and Additional Materials for any apparent defects, and that it has availed
itself of that opportunity; and
(v) the Software is provided as is, and Scaler has no obligation to provide the Licensee with
updates, upgrades, bug fixes, improvements or supplements to the Software or provide any
support services in connection with the Software.
(g) The application of the United Nations Convention on Contracts for the International Sale
of Goods (the Vienna Convention) to this EULA (by virtue of any law relevant to this
agreement) is excluded.

6. Intellectual Property and Title

(a) The Licensee acknowledges that the Software is the subject of copyright. The Licensee will not
during or any time after the expiry or termination of this EULA permit any act which infringes that
copyright and, without limiting the generality of the previously mentioned copyright, the Licensee
specifically acknowledges that it may not copy the Software or any part of it except as otherwise
expressly authorised or acknowledged by this EULA.

(b) You must not during or at any time after the expiry or termination of this EULA permit any act
which infringes any of Scaler’s trade marks (whether registered or unregistered) used in connec-
tion with the Software.

(c) This EULA does not transfer any ownership of the Software to the Licensee. Scaler retains all
right, title and interest in and to the Software and any copies of the Software (including all intel-
lectual property rights pertaining thereto).

7. Term of license
(a) The 14 Day Trial commences upon the Licensee’s acceptance of the terms and conditions set
out in this EULA.
(b) The EULA will continue beyond the 14 Day Trial upon payment of the License Fee and shall con-
tinue in effect until terminated in accordance with clause 7(c).
(c) This EULA may be terminated by Scaler in the following circumstances:

(i) if the Licensee is in breach of any term of this EULA;

(ii) if the Licensee, being a corporation, becomes the subject of insolvency proceedings;

(i) if the Licensee, being a firm or partnership, is dissolved;

(iv) if the Licensee uses the Software in any way that, in the reasonable opinion of

Scaler, does or is likely to cause damage to Scaler or bring it into disrepute; or

(v) if the Licensee destroys the Software for any reason.
(d) Upon termination, the Licensee or its representative will destroy any remaining copies of the
Software and Additional Materials or otherwise dispose of such material in the manner directed by
Scaler.
(e) Termination pursuant to this clause will not affect any rights or remedies which Scaler may
have otherwise under this EULA or at law.
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8. Limitation of Liability and Indemnity

(a) The Licensee will indemnify Scaler, its officers, employees, contractors and agents fully against
all liabilities, costs, charge, claim, liabilities and expenses (including legal expenses) which Scaler
may sustain or incur as a direct or indirect consequence of:
(i) a breach of the terms of this EULA by the Licensee (or its officers, employees, agents,
representatives or contractors);
(ii) any negligent or unlawful act or omission of the Licensee (or its officers, employees,
agents, representatives or contractors); and
(iii) the Licensee’s use of the Software except as otherwise provided in this EULA.

9. Privacy

The Licensee acknowledges and agrees that Scaler may collect, use, store and share the Licens-
ee’s personal information and usage information in accordance with Scaler’s privacy policy, as
amended from time to time in Scaler’s sole discretion, which is set out on Scaler’s website at
https://scalermusic.com/privacy-policy/ or such other website or location as notified to the
Licensee from time to time.

10. Assignment

The benefit of this EULA will not be dealt with in any way by the Licensee (whether by assignment,
sub-licensing or otherwise) without Scaler’s written consent (which may be withheld in its abso-
lute discretion). Scaler may transfer, novate or assign its rights and obligations under this EULA to
a third party at any time in its absolute discretion.

11. Waiver
Failure or neglect by either party to enforce at any time any of the provisions of this EULA will not
be construed or deemed to be a waiver of that party’s rights under this EULA.

12. Severability

If any part of this EULA is or becomes invalid or unenforceable, that part is severed from this
EULA. Such invalidity or unenforceability does not affect the validity or enforceability of the re-
maining provisions of this EULA.

13. Survival

Any indemnity under this EULA is independent from the other obligations of the parties and sur-
vives the termination of this EULA and any term which is expressed to survive termination of this
EULA or any term which by its nature is intended to survive termination of this EULA shall survive
the termination of this EULA.

14. Entire Agreement
This EULA and any documents expressly referred to in it (including Scaler’s privacy policy and the
Software user manual) constitutes the entire agreement between Scaler and the Licensee.

15. Governing law

This EULA will be governed by and construed according to the law of the Victoria, Australia.
Third Party Attribution

This Software may contain third party software components (or portions thereof).

The following legal notices, if any, provide attribution to these software components.

ASIO
ASIO is a trademark and software of Steinberg Media.

VST3
VST is a trademark of Steinberg Media Technologies GmbH, registered in Europe and other
countries.
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curl
Copyright (c) 1996 - 2022, Daniel Stenberg, daniel@haxx.se, and many contributors.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all
copies.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CON-
NECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertis-
ing or otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

json
Copyright (c) 2013-2021 Niels Lohmann

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the “Software”), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

mbedtls
This software uses mbedtls which is provided under the Apache 2.0 license.
You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software

distributed under the License is distributed on an “AS I1S” BASIS,

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and

limitations under the License.

zlib
(C) 1995-2017 Jean-loup Gailly and Mark Adler
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